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2. Workbook

The exercises in this workbook assume that users will have a basic understanding of 
GIS concepts and methods. Readers with no previous experience in GIS are suggested 
to read publications by Meaden and Kapetsky (1991) for an understanding of the basic 
concepts and de Graaf et al. (2003) for a first hands-on experience with GIS data and 
tools.  It is also assumed that users have read part 1 of this publication and have tested 
the main tools described in section 2.3 in part 1 and then described in detail in section 
1 in part 2 of this publication prior to completing the exercises of this workbook.

In addition, exercise procedures have been written with respect to the ArcView 3.x 
software only. However, an attempt has been made to sufficiently explain each step 
such that translations to other software might be possible.

The exercises are based on the case studies presented in part 1 of this publication. 
Thus, they address some of the key issues in inland aquatic resource management. 
The readers are advised to read the relevant case study in part 1  before they begin its 
corresponding exercise.   

Given that one of the most basic components of fisheries management is the 
inventory of resources, the first two exercises address concerns for local and regional 
resource inventory and analysis. Exercise 1 corresponds to the second case study 
(Inventory of fisheries habitats and fisheries productivities) and demonstrates a method 
to inventory fisheries habitats and fisheries productivities of African inland waters.  
Exercise 2 examines the creation of a surface waterbodies inventory using the United 
Republic of Tanzania and the Republic of Zimbabwe, and corresponds with the first 
case study (Surface waterbodies inventory). The order of these first two case studies 
are reversed because the analysis presented in Exercise 2 is difficult to replicate in a 
workbook exercise. The user must make a large number of decisions and judgment calls 
in Exercise 2, and in some cases there is no way to know what the correct answers are, 
so this workbook exercise is presented as an optional secondary exercise to illustrate a 
general methodological approach to identify unnamed features.

Exercise 3 explores estimates of potential fish yield as a critical value for fisheries 
managers by integrating relevant models in a GIS environment. Exercise 4 illustrates 
how users may create hydrological reports by summarizing statistical information 
across a range of human, environmental, and climatological factors using the Volta 
River megabasin as an example.

Exercise 5 is focused on the analysis of invasive and introduced aquatic species and 
illustrates how the AWRD provides a robust approach to the analysis of aquatic taxa. 
The last exercise provides users with guidelines and suggestions for the creation of base 
or reference maps which can be integrated to support reporting or for presentation 
purposes.

The exercises will reacquaint the user with the AWRD archive and technical manual 
and will help illustrate the usefulness of the AWRD. It should become clear that with 
the use of GIS (thus the AWRD) there is a surprisingly wide range of questions that 
can be answered using easily obtained information.

By completing the exercises in this workbook the reader should be able to re-create 
the results presented in the case studies presented in part 1 of this publication, while 
having the opportunity to explore the various AWRD datasets and tools. Time estimates 
were based on the amount of time a GIS expert took to complete the exercises.

Tick boxes are provided alongside each step of a given exercise to help the user keep 
track of where he/she left of.
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EXERCISE 1. Inventory of fisheries habitats and fisheries productivities

The purpose of this exercise is to make an inventory of the kinds and quantities of 
fisheries habitats of African inland waters.

Estimated time for completion: 1.5 hours

AWRD Tools  utilized

The tools employed for each of the analyses undertaken for this exercise are drawn 
primarily from the Data and Metadata Module and the Additional Tools and 
Customization Module, as well as some standard ArcView tools.  These tools were 
used to load and summarize data from the AWRD archive: select subsets of surface 
waterbody data based on feature class, and to join the gazetteer database with a cross-
tabulation table of feature class names. Table 2.1 summarizes the AWRD modules and 
tools used in this case study. 

TABLE  2.1
Summary of AWRD buttons and menu items

Button Menu option Action executed

Data and Metadata Module

View: “Load AWRD 
Data…”

Load AWRD Data: this button opens the main AWRD Data Inventory dialog, 
allowing users to search for and load data layers by name or by DBC. 

Additional Tools and Customization Module

“Summarize 
Theme…”

Summarize Theme: this function allows you to group features in a theme  based on 
common attribute values, and then generate several descriptive statistics  for each 
group.

Part 1. Counts and areas of surface waterbodies from three sources

In this section we will make an inventory of the types, quantities and total areas of 
potential fisheries habitats in African inland waters, based on three datasets in the 
AWRD data archive.  We will then compare those three datasets.

Materials and methods 
Data utilized
The data utilized for the Tanzanian portion of this case study are presented Table 2.2.
TABLE 2.2
Summary and purpose of data used for comparison of surface waterbody counts and areas

Name Description Filename File location Data utilization or 
purpose

Consolidated 
WCMC Wetlands

Seamless recompilation 
of country based 
wetlands

Wtlnd_Py.shp [AWRD_Data]\data\
swb_dbc

Comparison of total 
area and waterbody 
counts among three 
waterbody sources.

Harmonized 
DCW-VMap0 
Surface Water 
Bodies

Seamless and 
topologically robust 
derivative of source 
DCW and VMap0 
perennial/non-perennial 
SWBs from VMAP0-IW, 
DCW-DNNET and DCW-
LCPOLY sources

dniw_hyd.shp [AWRD_Data]\data\
swb_dbc

Consolidated 
VMap0 Surface 
Water-Hydro 
Features

Seamless and 
topologically robust 
derivative of source 
VMap0  SWB and 
related hydrological 
features, i.e. swamps, 
etc. data layers

vmap_py.shp [AWRD_Data]\data\
gztr_dbc
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Complete Table 2.3

TABLE 2.3
Counts and surface areas of surface waterbodies from three sources with non-fisheries habitats 
removed

Data set WCMC DCW VMap0

Type Area (ha) Number Area (ha) Number Area (ha) Number

Perennial Waterbodies

Non-Perennial Waterbodies

Flood-Plain/Wetlands

Pans

Totals

Methods
Open ArcView and start the exercise by following the steps described in points 
below.

Click on the  button and load the following three datasets.  You can 
find them by either typing the name or filename in the “Search Text” textbox (you may 
use the * and ? wildcard characters), or by clicking on the respective DBC and finding 
the file in the list.
❑ 1. Consolidated WCMC Wetlands (Wtlnd_Py.shp); from the Surface Waterbodies 

DBC.
❑ 2. Harmonized DCW-VMap0 Surface Water Bodies (dniw_hyd.shp); from the 

Surface Waterbodies DBC.
❑ 3. Consolidated VMap0 Surface Water-Hydro Features (vmap_py.shp); from the 

Surface Waterbodies DBC.

Change the theme names to the short versions by clicking the “View” menu item 
“Toggle AWRD data to Short Theme Names.”  You might have to click this menu item 
two times.

Change the legend of Wtlnd_Py.shp so that it shows waterbodies classified according 
to hydrological type [hyd_sum_tp]:
❑ 1. Double-click the Wtlnd_Py.shp legend in the View Table of Contents.
❑ 2. Set the Legend Type to “Unique Value”
❑ 3. Set the Values Field to “Hyd_sum_tp”.

Calculate the areas and counts of each hydrological class in the WCMC dataset 
(Wtlnd_Py.shp).
❑ 1. Use the Summarize Theme tool  to summarize Wtlnd_Py.shp based on 

“Hyd_sum_tp”.  Make sure to include the SUM of “Laea_ha” values (i.e. in the 
Summary Table Definition dialog, set Field = “Laea_ha” and Summarize By = 
“Sum”, then click “Add”.  For more information refer to Section 1.6, “Statistical 
Analysis Module”, in the technical manual).

❑ 2. Insert the calculated values into Table 2.3.
❑ 3. You may use the standard ArcView “Statistics” menu item (in the “Field” 

menu) to quickly calculate the sums of the count and area values for the 4 
classes of surface waterbodies listed in Table 2.3.  Note:  To get the statistics on 
only the 4 classes, select the 4 classes in the table before running the “Statistics” 
menu item.
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Calculate the areas and counts of each hydrological class in the DCW dataset (dniw_
hyd.shp).
❑ 1. Use the Summarize Theme tool  to summarize dniw_hyd.shp based on 

“Hyd_code”.  Make sure to include the SUM of “Laea_ha” values.
❑ 2. The class “Perennial Water Bodies” corresponds with [Hyd_code] = 1.  Enter the 

count and area values for [Hyd_code] = 1 into the “Perennial Water Bodies” row 
in Table 2.3.

❑ 3. The class “Non-Perennial Water Bodies” corresponds with [Hyd_code] = 1.  
Enter the count and area values for [Hyd_code] = 2 into the “Non-Perennial 
Water Bodies” row in Table 2.3.

❑ 4. The class “Flood-Plain/Wetlands” corresponds with [Hyd_code] = 14 and [Hyd_
code] = 15.  Enter the count and area values for [Hyd_code] = (14 and 15) into the 
“Flood-Plain/Wetlands” row in Table 2.3.

❑ 5. The class “Pans” corresponds with [Hyd_code] = 3 and [Hyd_code] = 5.  Enter 
the count and area values for [Hyd_code] = (3 and 5)  into the “Pans” row in Table 
2.3.

Calculate the areas and counts of each hydrological class in the VMap0 dataset (vmap_
py.shp).
❑ 1. Use the Summarize Theme tool  to summarize vmap_py.shp based on “Bnd_

code”.  Make sure to include the SUM of “Laea_ha” values.
❑ 2. The class “Perennial Water Bodies” corresponds with [Bnd_code] = 1.  Enter the 

count and area values for [Bnd_code] = 1 into the “Perennial Water Bodies” row 
in Table 2.3.

❑ 3. The class “Non-Perennial Water Bodies” corresponds with [Bnd_code] = 1.  
Enter the count and area values for [Bnd_code] = 2 into the “Non-Perennial 
Water Bodies” row in Table 2.3.

❑ 4. The class “Flood-Plain/Wetlands” corresponds with [Bnd_code] = 14, [Bnd_code] 
= 16, and [Bnd_code] = 17.  Enter the count and area values for [Bnd_code] = (14, 
16 and 17) into the “Flood-Plain/Wetlands” row in Table 2.3.

❑ 5. The class “Pans” corresponds with [Bnd_code] = 3 and [Bnd_code] = 5.  Enter the 
count and area values for [Bnd_code] = (3 and 5)  into the “Pans” row in Table 
2.3.

Notice the differences between data sources:  WCMC and DCW contain 
approximately the same total area of waterbodies, while VMap0 contains considerably 
less.  This suggests that WCMC and DCW may include waterbodies that are missed 
by VMap0.

However, VMap0 and DCW both contain similar total numbers of waterbodies, 
while WCMC has a considerably smaller number.  This suggests that multiple 
waterbodies may be aggregated into single units in the WCMC data, while being 
maintained as separate entities in the DCW and VMap0 data.

There may be a variety of reasons why datasets in general differ.  In this case, the 
metadata for the three datasets show that both the DCW and VMap0  were originally 
derived from VMap0 sources, and have since been postprocessed using different 
methods.  The WCMC data comes from a different source entirely.
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Part 2. Surface areas of WCMC inland fisheries habitats in Africa

In this section we will calculate the surface area of various classes of fisheries habitats 
from the World Conservation Monitoring Center (WCMC) dataset of surface 
waterbodies.

Materials and methods 
Data utilized

The data utilized for the Tanzanian portion of this case study are presented Table 
2.4.

TABLE 2.4
Summary and purpose of data used for comparison of surface waterbodies counts and areas

Name Description Filename File location Data utilization or 
purpose

Consolidated 
WCMC 
Wetlands

Seamless recompilation 
of country based 
wetlands

Wtlnd_Py.shp [AWRD_Data]\data\swb_dbc
Inventory of WCMC 
Fisheries Habitat 
Classes.

Complete Table 2.5

TABLE .2.5
Surface areas of WCMC inland fisheries habitats of Africa

Fisheries habitats Surface area

(Ha)
Fresh water marsh
Impoundment
Lagoon
Lake
Mangrove
Pools
Semi-permanent lake
Swamp forest
Tidal wetland/estuary/coastal
Grand total

Methods
Open ArcView and start the exercise by following the steps described in points 
below.

Click on the  button and load the following dataset.  You can find it 
by either typing the name or filename in the “Search Text” textbox (you may use the * 
and ? wildcard characters), or by clicking on the Surface Waterbodies DBC and finding 
the file in the list.
❑ 1. Consolidated WCMC Wetlands (Wtlnd_Py.shp); from the Surface Waterbodies 

DBC.

Change the theme names to the short versions by clicking the “View” menu item 
“Toggle AWRD data to Short Theme Names.”  You might have to click this menu item 
two times.

Make sure that the legend of Wtlnd_Py.shp shows waterbodies classified according to 
waterbody class [classtx]:
❑ 1. Double-click the Wtlnd_Py.shp legend in the View Table of Contents.
❑ 2. Set the Legend Type to “Unique Value”
❑ 3. Set the Values Field to “classtx”.
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Calculate the areas and counts of each waterbody class in the WCMC dataset (Wtlnd_
Py.shp).
❑ 1. Use the Summarize Theme tool  to summarize Wtlnd_Py.shp based on 

“classtx”.  Make sure to include the SUM of “Laea_ha” values.
❑ 2. Insert the calculated values into Table 2.5.
❑ 3. You may use the standard ArcView “Statistics” menu item (in the “Field” menu) 

to quickly calculate the sums of the count and area values for the 9 classes of 
surface waterbodies that constitute potential fisheries habitat listed in Table 2.5.  
Note:  To get the statistics on only the 9 classes, select the 9 classes in the table 
before running the “Statistics” menu item.

Part 3. Counts of GNS gazetteer fisheries habitats in Africa

In this section we will calculate the number of hydrological features in Africa, based on 
the GNS Gazetteer dataset.  Many of these hydrological feaures might serve as fisheries 
habitats.

Materials and methods 
Data utilized

The data utilized for the Tanzanian portion of this case study are presented Table 
2.6.

TABLE 2.6
Summary and purpose of data used for comparison of surface waterbodies counts and areas

Name Description Filename File Location Data Utilization or 
Purpose

Cross Table 
of potential 
coding 
attributes

Seamless 
recompilation of 
country based 
wetlands

gns_gztr_c.dbf [AWRD_Data]\data\gztr_dbc\
dbf_code\

Table of code 
names which 
correspond with 
GNS Gazetter 
codes.

GEOnet 
Gazetteer 
Database

1.2 million named 
locations under 6 
major topical classes

gns_gztr.shp [AWRD_Data]\data\gztr_dbc\

Comprehensive 
set of features in 
Africa, including 
over 267 000 
hydrological 
features.

Complete Table 2.7

TABLE 2.7 
Counts of fishery habitats for the African continent from the GNS dataset

Fisheries habitat Count Fisheries habitat Count Fisheries habitat Count

stream marine channel lost river

wadi channel mangrove swamp

well intermittent wetland seaplane landing area

intermittent stream anchorage streams

spring(s) gulf salt evaporation ponds

lake strait abandoned watercourse

waterhole(s) section of stream aqueduct

water tank lake bed(s) irrigation system

bay mud flat(s) irrigation ditch

wells wadies stream bend

pond section of lake fishing area

ravine(s) harbor(s) intermittent salt lake
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tidal creek(s) estuary salt marsh

sabkha(s) stream mouth(s) headwaters

wetland crater lake reach

reservoir(s) sea section of waterfall(s)

pool(s) anabranch wadi junction

marsh(es) ponds whirlpool

canal bight(s) section of reef

reef(s) lake channel(s) hot spring(s)

cove(s) roadstead salt pond

intermittent lake section of wadi section of lagoon

swamp salt lake wadi mouth

shoal(s) lakes confluence

inlet navigation canal(s) intermittent lakes

waterfall(s) tidal flat(s) intermittent pool

intermittent pond navigation channel lagoons

bank(s) irrigation canal section of harbor

section of intermittent 
stream

glacier(s) sulphur spring(s)

distributary(-ies) canalized stream crater lakes

rapids abandoned well sill

drainage canal ditch watercourse

lagoon docking basin Grand Total

Methods
Open ArcView and start the exercise by following the steps described in points 
below.

Click on the  button and load the following dataset.  You can find it 
by either typing the name or filename in the “Search Text” textbox (you may use the 
* and ? wildcard characters), or by clicking on the Gazetteer DBC and finding the file 
in the list.
❑ 1. GEOnet Gazetteer Database (gns_gztr.shp);from the Gazetteer DBC.
❑ 2. GNS Gazetteer Cross Table of potential coding attributes (gns_gztr_c.dbf); from 

the Gazetteer DBC.  Note:  This does not add a theme to the view.  This dataset 
is a dBASE table, and will therefore add a new table to your ArcView project.

The GEOnet Gazetteer Database contains names for each feature, but it only includes 
a code for the class of feature.  If we want to know the names of the feature classes, then 
we must join the table of class names to the GEOnet Gazetteer attribute table.
❑ 1. Open the GNS Gazetteer Cross Table of potential coding attributes table (#2 

above).
❑ 2. Click on the field name [DSG].
❑ 3. Open the attribute table for the GEOnet Gazetteer Database.
❑ 4. Click on the field name [Dsg_code].

❑ 5. Click the “Join” button  to join the two tables.  Note:  The “Join” button 
will only become active if compatible fields have been selected in both tables.  
For more information on joining tables, please refer to “Joining Tables” in the 
ArcView help files.
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The GEOnet Gazetteer database contains types of features.  We are only interested in 
the hydrological features in this example.  Hydrological features are designated with a 
value of “H” in the [FC] field.
❑ 1. While the GEOnet Gazetteer atribute table is open, select the hydrological features 

by clicking the Query button  and using the following query string:

( [Fc] = “H” )
❑ 2. You should have 267 039 hydrological features selected for Africa.  Summarize 

these by [Code_type] using the  button, and enter the values into Table 2.7.

Exercise Summary
This exercise demonstrated how to generate inventories of potential fisheries habitats, 
including counts and areas, extracted from four data sources in the AWRD archive. 
These inventories describe fisheries habitats across all of Africa, however, the 
methodology describe in this exercise could be easily adapted to analyzing habitat 
availability in any region of interest.
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EXERCISE 2. Surface waterbodies inventory (Optional exercise)

The purpose of the following exercise is to determine the viability of creating a surface 
waterbody (SWB) inventory by integrating the historic data records contained in the 
SIFRA reports with spatial data layers from both within the AWRD data archive and 
from external sources. 
  Exercise No. 2

This case study demonstrates two approaches to examine the potentials and 
limitations of combining data from multiple sources, to get a more comprehensive 
description of SWB features. In particular the first approach attempts to extract SWB 
names from one data source and apply those names to a second data source that does not 
have names.  The second approach produces an SWB attribute table based on SIFRA 
data, and links that table to two other SWB data sources from the AWRD archive.

This exercise illustrates methodological approaches for identifying surface 
waterbodies based on attributes from multiple datasets.  The process can be complex 
and often requires that the user make judgement calls with insufficient data.  The 
authors of the AWRD felt that this exercise would be useful because it provides 
examples of complex analyses, but it is not a critical component of the overall AWRD 
toolset and therefore this exercise is offered as an optional exercise only.

Estimated time for completion: 1.5 hours

AWRD Tools  utilized
The tools employed for each of the analyses undertaken for this exercise were based 
primarily on those found in the Data and Metadata, Statistical Analysis and Additional 
Tools and Customization Modules, plus selected Add-On Extensions of the AWRD. 
These tools were used to: select subsets of SWB data specific to the country of interest; 
conduct a semi-automated determination of a name for each waterbody polygon; a 
cross-tabulation to the SWB specific data within the SIFRA documents; and lastly, the 
individual and consolidated reporting of summary statistics for named waterbodies.  
Table 2.8 summarizes the modules and tools used throughout this case study. 

TABLE  2.8
Summary of AWRD buttons and menu items

Button Menu option Action executed
Data and Metadata Module

View: “Load 
AWRD Data…”

Load AWRD Data: this button opens the main AWRD Data Inventory dialog, 
allowing users to search for and load data layers by name or by DBC. 

Additional Tools and Customization Module
AWRD Tools: 
“Select by 
Theme…”

Select by Theme:  this tool provides a means to select features from one theme that 
have some type of proximity relationship (i.e. intersect with, are contained by, are 
within distance of, etc.) with the selected features of another theme.

AWRD Tools: 
“Query Builder…”

Query Builder:  this tool provides a comprehensive way to either select or view 
features in a theme based on a complex query to the feature attribute table.

N/A
Import Table from Excel: This tool converts an Excel table to a dBASE file and adds 
it to ArcView.  It is included in the Aquatic Species Module because occasionally 
aquatic species data may be downloaded in Excel format.

Statistical Analysis Module

“Summarize 
Theme…”

Summarize Theme: this function allows you to group features in a theme  based on 
common attribute values, and then generate several descriptive statistics  for each 
group.

Add-On Extensions

AWRD Tools: 
“Additional AWRD 
Extensions”

Nearest Features v. 3.8a: this tool allows the user to find which features are closest 
to each of a set of other features, based on both the centroid distance and the 
distance between the closest edges given user defined tolerance. The tool can also 
calculate, return, and encode the distance and bearing between the closest features.

AWRD Tools: 
“Additional 
AWRD Extensions

Identify Features Within a Distance:  This extension works through each selected 
feature in an Input theme and identifies the features in a single or multiple 
Comparison themes that are within a specified distance of it.

SIFRA Compendium

N/A
Open SIFRA Data by Clicking on Country: this function can be used to open any 
country based SIFRA Compendium file for Africa by clicking over the appropriate 
country in the active View. 
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Part 1. United Republic of Tanzania

Materials and methods

Data utilized
The data utilized for the Tanzanian portion of this case study are presented Table 2.9.

TABLE 2.9
Summary and purpose of data used for Tanzanian analysis

Name Description Filename File location Data utilization or purpose

AfriCover 
Surface Water 
Body Features

Africover 
polygonal data 
layer

africvr.shp [AWRD_Data]\data\swb_dbc A Surface Waterbody 
dataset, without name 
attributes for the 
waterbodies, covering 8 
countries in eastern Africa 

SADC Surface 
Water Body 
Database

SADC-WRD 
SWB point data 
layer

sadc_swb.
shp

[AWRD_Data]\data\swb_dbc Potential source of names 
for Africover surface 
waterbodies for linkage to 
SIFRA waterbodies reporting 
data

Surface Water 
Body Features 
from GEOnet 
Gazetteer

NIMA GNS 
Gazetteer SWB 
specific subset 
point data layer

gns_swb.
shp

[AWRD_Data]\data\gztr_dbc Alternate source of names 
for Africover surface 
waterbodies for linkage to 
SIFRA waterbodies reporting 
data

VMap0 
National-Ad1 
Polygonal 
Boundaries

VMap0 “Basic” 
political 
boundaries 
data layer

Ad1_Py.shp [AWRD_Data]\data\avec_dbc Used to create Tanzanian 
subsets of SADC-WRD and 
GNS SWB data layers

Methods
Open ArcView and start the exercise by following the steps described in points 
below.

Click on the  button and load the following four datasets.  You can 
find them by either typing the name or filename in the “Search Text” textbox (you may 
use the * and ? wildcard characters), or by clicking on the respective DBC and finding 
the file in the list.
❑ 1. AfriCover Surface Waterbody Features (africvr.shp); from the Surface Waterbodies 

DBC.
❑ 2. VMap0 National-Ad1 Polygonal Boundaries (Ad1_Py.shp); from the Additional 

Vector Data DBC.
❑ 3. Surface waterbody features from GEOnet Gazetteer (gns_swb.shp); from the 

Gazetteer Data DBC.
❑ 4. SADC Surface Waterbody Database (sadc_swb.shp); from the Surface Waterbodies 

DBC.

Change the theme names to the short versions by clicking the “View” menu item 
“Toggle AWRD data to Short Theme Names.”  You might have to click this menu item 
two times.
Create subsets of africvr.shp, sadc_swb.shp and gns_swb.shp.  This is a two-step 
process, first selecting all features that lie within the United Republic of Tanzania, and 
then selecting the subset of those  features that represent waterbodies.

❑ 1. First select Tanzania from the country boundaries dataset (Ad1_Py.shp).  You 
may use either the Query Builder tool  or the standard ArcView selection 
tools. You will see Tanzania highlighted in yellow in your View.
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❑ 2. Zoom in to the extent of Tanzania by clicking the standard ArcView “Zoom to 
Selection” button.

❑ 3. Select the sadc_swb.shp surface waterbody points that intersect with Tanzania.  
Do this by clicking on the sadc_swb.shp theme to make it active, then clicking 
the “Select By Theme” tool . Select features from the active theme (i.e. Sadc_
swb.shp) that “Intersect” the selected features of “Ad1_Py.shp” (i.e. Tanzania). 
Click the “New” button  and you will see all sadc_swb features 
highlighted in yellow for Tanzania.  At the bottom of the dialog, you should see 
that approximately 328 points are selected.

❑ 4. Refine the selection to include only features that are known to be waterbodies.  
Click on the Query Builder tool , make sure that the “Select” option is chosen 
(not “Set Theme Definition”), and enter the following query string (this query 
string is basically identifying all points that are not of type “Unknown”):

( [Type] <> “U” )
❑ 5. Click the Subset button  to select the subset of waterbody 

points.  At the bottom of the dialog, you should see that approximately 127 points 
are now selected.

❑ 6. The next step is to convert this subset of features into a new independent shapefile. 
Click “Convert to shapefile...” from the “Theme” menu and then choose a name 
(e.g. Tz_sadc_wb.shp) and the location in your hard drive where you wish to 
store this new theme.

❑ 7. Now repeat steps 3 – 6 using the “gns_swb.shp” and “africvr.shp” datasets.  The 
Query Builder Search strings are as follows:

 a. Gns_swb.shp:  ( [Fc] = “H” )
 b. Africvr.shp:  ( [Lcid] = “WB” )

Once you have created the new subset shapefiles of africvr.shp (i.e. Tz_afcvr_wb.shp), 
sadc_swb.shp (i.e. Tz_sadc_wb.shp), and Gns_swb.shp (i.e. Tz_Gns_wb.shp) you can 
now run the extensions “Identify Features Within Distance” and “Nearest Features” 
to find which Tz_sadc_wb points are closest to each Tz_afcvr_wb polygon.  The 
Tz_sadc_wb points will provide the first estimate of the name that should be associated 
with each Tz_afcvr_wb polygon.  Important:  This method will only provide a 
rough estimate of the correct names of the Africover waterbody polygons!   The logic 
assumes that intersecting or nearby SADC or Gazetteer points will be referring to 
the same waterbody as the Africover polygon, and that therefore we can identify the 
Africover polygon name using these intersecting points, but this assumption may not 
be valid in many cases.  Furthermore, some Africover polygons may intersect multiple 
SADC or Gazetteer points, and in such cases there is no simple method to determine 
which point is the correct one to use to get the Africover waterbody name.  This 
process will require the user to examine the outputs closely and make judgment calls 
about the correct names to apply.

❑ 1. First add a new String field to Tz_afcvr_wb to hold the new waterbody names.  
Make sure that you select “string” from the drop-down list of field types, and 
that it is of sufficient length to hold any potential names (50 characters should 
be enough).  For help on adding new fields to ArcView tables, please refer to 
“Adding and deleting fields in a table” in the ArcView help files.

❑ 2. Click “Additional AWRD Extensions” from the AWRD interface and then 
load “Identify Features Within Distance” by checking the box on the left of the 
extension name.  This will add the  button to your View button bar.
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❑ 3. Click the “AWRD” button under the “Add-On Extensions” section of the 
AWRD interface, and then load “Nearest Features” by checking the box on the 
left of the extension name.  This will add the  button to your View button 
bar.

❑ 4. First identify which Tz_afcvr_wb polygons intersect with multiple Tz_sadc_wb 
points.  In these cases, there will be multiple potential names to assign to the 
Tz_afcvr_wb polygons, and therefore these polygons will need to be examined 
individually.  Make sure that no Tz_afcvr_wb polygons or Tz_sadc_wb points are 
selected before beginning this analysis.

❑ 5. Click the  button and select Tz_afcvr_wb as the input theme, with “Auto ID” 
as the input theme ID field.  Click ‘OK’.

❑ 6. In the next dialog, select Tz_sadc_wb as the comparison theme and “Name” as the 
comparison theme ID field.  Click ‘Add’ to add to the list of comparison themes, 
and then click ‘OK’ to move to the next dialog.

❑ 7. In the “Select Analysis Type” dialog, select the 4th option down (Identify Features 
if any part of the shape is less than ____ map units), and enter a value of 0.0001 as 
the number of map units.  Click ‘OK’.

❑ 8. In the “Select OUTPUT Data:” dialog, make sure that the first output table 
option is selected (“Identify each INPUT feature, along with the number of 
Comparison Features within the specified distance”).  Also make sure that the 
options “Distance to Closest Edge”, “Input Feature ID” and “Comparison 
Feature ID” are selected.  At the bottom of the dialog, select the option “Join 
Tables”.  Click ‘OK’.

❑ 9. Simply click ‘OK’ for the next two dialogs, and the extension will go to work.  
Upon completion, the extension will create a table listing exactly how many 
Tz_sadc_wb points are less than 0.0001 degrees of each Tz_afcvr_wb polygon, 
and automatically join that table with the Tz_afcvr_wb attribute table.

❑ 10. Identify all Tz_afcvr_wb polygons that intersect with multiple Tz_sadc_wb 
points using the Query Builder tool .  Select the theme Tz_afcvr_wb and 
use the following query string:

( [Count of Features] > 1 )
❑ 11. Based on this query, we see that 10 Tz_afcvr_wb polygons intersect multiple 

Tz_sadc_wb points.  Examine each of these Tz_afcvr_wb polygons separately 
and estimate which Tz_sadc_wb point is the most likely to have the correct 
name.  Set the attribute table to “Editable” and type this name into the new 
“Name” field.  Save your edits after you have entered the names.

❑ 12. For the remaining 384 Tz_afcvr_wb polygons, we will try using the nearest 
single Tz_sadc_wb point as our best guess for the name of the waterbody.  We 
will limit our search distance to 25 km from each Tz_afcvr_wb polygon.

❑ 13. Click the View Properties menu item and make sure that the View Distance 
Units are set to Kilometers.

❑ 14. Select the remaining 384 unnamed Tz_afcvr_wb polygons.
❑ 15. Click the  to start the Nearest Features tool.  Select Tz_afcvr_wb as the input 

theme, with “Auto ID” as the input theme ID field.  Click ‘OK’.
❑ 16. In the next dialog, select Tz_sadc_wb as the comparison theme and “Name” as 

the comparison theme ID field.  Click ‘Add’ to add to the list of comparison 
themes, and then click ‘OK’ to move to the next dialog.

❑ 17. Enter “1” for the “Number of Closest Comparison Features per Input Feature:”, 
and select the option “Comparison Feature ID”.
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❑ 18. Click the “Additional Options” button and set a maximum search distance of 
25 km.  Also check the option to join the RESULTS table with the input theme 
attribute table.

❑ 19. Click ‘OK’ through the remaining dialogs and the tool will go to work.  As soon 
as it finishes, it should alert us that 142 Tz_afcvr_wb polygons were not within 
25 km of any Tz_sadc_wb points.  The output table will be automatically joined 
with the Tz_afcvr_wb attribute table, so open the table and view the results.

❑ 20. Use the standard ArcView Table Query Builder to select all records in which the 
nearest Tz_sadc_wb name is not equal to either “-None –“, “name unknown”, 
or “”.  The calculation string is as follows:

 ( [n1_ID] <> “- None -”) and ([n1_ID] <> “name unknown”) and ([n1_ID] <> “” )
❑ 21. Use the standard ArcView Calculate function to calculate the remaining 122 

names to the Tz_afcvr_wb name field.

Using this method, you have assigned potential names to 132 of 394 of the Tz_afcvr_
wb waterbody polygons.  If you wish, you may repeat steps 15 – 21 above with the Tz_
Gns_wb gazetteer points to search for possible names for the remaining Tz_afcvr_wb 
polygons, or for alternate names for the 132 polygons you have already named. 

Part 2. Republic of Zimbabwe

This section illustrates how data can be extracted from external sources such as SIFRA 
documents, and then linked to existing AWRD archive data.

Materials and methods
Data utilized
Table 2.10 provides a summary listing of the data utilized during the Zimbabwean 
portion of the case study.

TABLE 2.10
Summary and purpose of data used for Zimbabwean analysis

Name Description Filename File location Data utilization or 
purpose

Harmonized 
DCW-VMap0 
Surface Water 
Bodies

VMap0 5th 
Edition Inland 
Waterbodies 
data layer

dniw_hyd.
shp

[AWRD_Data]\data\swb_dbc Primary baseline 
source for names and 
potential linkage to 
SIFRA Zimbabwean 
SWB reports

Source book 
for the 
inland fishery 
resources of 
Africa Vol. 1

SIFRA Zimbabwe 
report

Zimbabwe.
htm

[AWRD_Data]\docs\src_book\ Limnological and 
fisheries data to be 
attributed to Africover 
waterbodies data for 
Zimbabwe.

SADC Surface 
Water Body 
Database

SADC-WRD SWB 
point data layer

SADC-
SWB.shp

[AWRD_Data]\data\swb_dbc Secondary source of 
names for identifying 
SWBs for linkage to 
SIFRA waterbodies 
reporting data

VMap0 
National-Ad1 
Polygonal 
Boundaries

VMap0 “Basic” 
political 
boundaries data 
layer

Af_pbndb.
shp

[AWRD_Data]\data\avec_dbc Used to create 
buffered Tanzanian 
subsets of SADC-WRD 
and GNS SWB data 
layers
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Methods
Open ArcView and start the exercise by following the steps described in points 
below.

Click on the  button and load the following three datasets.  You can 
find them by either typing the name or filename in the “Search Text” textbox (you may 
use the * and ? wildcard characters), or by clicking on the respective DBC and finding 
the file in the list.
❑ 1. VMap0 National-Ad1 Polygonal Boundaries (Ad1_Py.shp); from the Additional 

Vector Data DBC.
❑ 2. Harmonized DCW-VMap0 Surface Waterbodies (dniw_hyd.shp); from the 

Surface Waterbodies DBC.
❑ 3. SADC Surface Waterbody Database (sadc_swb.shp); from the Surface Waterbodies 

DBC.

Change the theme names to the short versions by clicking the “View” menu item 
“Toggle AWRD data to Short Theme Names.”  You might have to click this menu item 
two times.

Create subsets of dniw_hyd.shp and sadc_swb.shp.  This is a two-step process, first 
selecting all features that lie within the Republic of Zimbabwe, and then selecting the 
subset of those  features that represent waterbodies.

❑ 1. Set your View Map Units to Decimal Degrees, and Distance Units to Kilometers 
by clicking the View menu, then Properties. 

❑ 2. First select Zimbabwe from the country boundaries dataset (Ad1_Py.shp).  You 
may use either the Query Builder tool  or the standard ArcView selection 
tools. You will see Zimbabwe highlighted in yellow in your View.

❑ 3. Zoom in to the extent of Zimbabwe by clicking the standard ArcView “Zoom to 
Selection” button.

❑ 4. Select the sadc_swb.shp surface waterbody points that intersect with Zimbabwe.  
Do this by clicking on the sadc_swb.shp theme to make it active, then clicking the 
“Select By Theme” tool . Select features from the active theme (i.e. Sadc_swb.
shp) that “Are Within Distance Of” the selected features of “Ad1_Py.shp” (i.e. 
Zimbabwe).  Set a distance value of 1 km.  Click the “New” button  
and you will see all sadc_swb features highlighted in yellow for Zimbabwe.  At 
the bottom of the dialog, you should see that approximately 9 938 points are 
selected.

❑ 5. Refine the selection to include only features that are known to be waterbodies.  
Click on the Query Builder tool , make sure that the “Select” option is chosen 
(not “Set Theme Definition”), and enter the following query string (this query 
string is basically identifying all points that are not of type “Unknown”):

( [Type] <> “U” )
❑ 6. Click the Subset button  to select the subset of waterbody points.  

At the bottom of the dialog, you should see that the number of selected points 
(9 938) has not changed, indicating that all SADC SWB points within 1 km of 
Zimbabwe are known to be actual surface waterbodies.

❑ 7. The next step is to convert this subset of features into a new independent shapefile. 
Click “Convert to shapefile...” from the “Theme” menu and then choose a name 
(e.g. Zi_sadc_swb.shp) and the location in your hard drive where you wish to 
store this new theme.
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❑ 8. Now repeat steps 3 – 6 using the “dniw_hyd.shp” dataset to create a new subset 
named “Zi_dniw_swb.shp”.  The Query Builder Search string is as follows:

a. dniw_hyd.shp:  ([Hyd_code] = 1)

Next create a table of surface waterbody data extracted from the SIFRA compendium 
for the Republic of Zimbabwe.  This table will then be linked to the two datasets you 
just created (Zi_sadc_swb and Zi_dniw_swb).  In the interest of time, this example will 
only demonstrate this procedure using the five largest waterbodies in the Republic of  
Zimbabwe, rather than all waterbodies possible.

The following discussion will demonstrate how to create the table in Excel and then 
import it into ArcView, because creating and editing tabular data is easier in Excel than 
in ArcView.  However, if Excel is not available, then the data table can also be created 
completely within ArcView.

❑ 1. Using Table 2.11 as a template, open up a blank worksheet in Excel and make 
field names for 7 fields (Name, Year, Volume, Area, Max_Depth, SADC_Link and 
VMAP_Link).  Add the following “Name” values for the five largest waterbodies 
in the Republic of Zimbabwe, according to the SIFRA compendium:

TABLE 2.11
Sample excel table for the Republic of Zimbabwe watersheds

Name Year Volume Area Max_Depth SADC_link VMAP_link

Kariba

Kyle

Robertson

McIlwaine

McDougall

❑ 2. Use the  tool to click on the country of Zimbabwe in the view to open up 
the SIFRA compendium for Zimbabwe.

❑ 3. Scroll down to Table 2:  Selected Morphological Data and Use of Zimbabwe 

Reservoirs.  Find the records for the five largest waterbodies (Kariba, Kyle, 
Robertson, McIlwaine and McDougall), and add the Year, Volume, Area and 
Maximum Depth values for these waterbodies to your Excel table.

Next try to find these same five waterbodies in your Zi_sadc_swb and Zi_dniw_swb 
datasets.

❑ 1. You must decide which Zi_sadc_swb features correspond with the five waterbodies 
in Table 2.11.  

a. Identify what waterbody names are available in your Zi_sadc_swb dataset by 
using the Summarize Theme tool  to list all the “Name” values.

b. There are two Zi_sadc_swb features named “Kariba”.  Use the Query Builder 
tool  to select these two records, and then open the attribute table and 
examine them.  Notice that one record has a “Country” value of “ZM” (for 
Zambia) while the other has a “Country” value of “ZW” (for Zimbabwe).  
This is reasonable considering that Kariba lies on the border between the 
Republic of Zambia and the Republic of Zimbabwe.  We are interested in the 
“Zimbabwe” point, which has a “Nat_id” value of 10880, so enter the value 
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“10880” into the “SADC_Link” field for the waterbody “Kariba” in your 
Excel table

c. There are no Zi_sadc_swb features with the word “Kyle” anywhere in the 
name.  However, with a bit of searching we can find that there is a Zi_sadc_swb 
feature very close to the Zi_dniw_swb polygon named “Lake Kyle”, which 
has a “Surf__area” value of 9 105 ha and a “Capacity” value of 1 425 000 000 
m2, both of which correspond to our SIFRA data for Kyle.  This Zi_sadc_swb 
feature has a “Nat_id” value of 6183, so enter the value “6183” into the 
“SADC_Link” field for the waterbody “Kyle” in your Excel table.

d. There are no Zi_sadc_swb features with the word “Robertson” anywhere 
in the name.  However, with a bit of searching we can find that there is a 
Zi_sadc_swb feature very close to the Zi_dniw_swb polygon named “Lake 
Manyame”, which has a “Comments” value of “Also known as Robertson 
(=Darwendale)”.  This Zi_sadc_swb feature has a “Nat_id” value of 2599, 
so enter the value “2599” into the “SADC_Link” field for the waterbody 
“Robertson” in your Excel table.

e. There are no Zi_sadc_swb features with the word “McIlwaine” anywhere 
in the name.  However, there is one Zi_sadc_swb feature with the word 
“McIllwaine”, which you can find using the Query Builder tool  with the 
following search string:

( [Name].Contains(“waine”) )

This Zi_sadc_swb feature has a “Nat_id” value of 9793, so enter the value 
“9793” into the “SADC_Link” field for the waterbody “McIlwaine” in your 
Excel table.

f. There are no Zi_sadc_swb features with the word “McDougall” anywhere 
in the name.  However, with a bit of searching we can find that there is a 
Zi_sadc_swb feature very close to the Zi_dniw_swb polygon named “Lake 
MacDougall”, which has a “Surf__area” value of 2 023 ha and a “Capacity” 
value of 285 000 000 m2, both of which correspond to our SIFRA data for 
McDougall.  This Zi_sadc_swb feature has a “Nat_id” value of 6303, so enter 
the value “6303” into the “SADC_Link” field for the waterbody “McDougall” 
in your Excel table.  

❑ 2. You must decide which Zi_dniw_swb features correspond with the five waterbodies 
in Table 2.11.

a. Identify what waterbody names are available in your Zi_dniw_swb dataset by 
using the Summarize Theme tool  to list all the “Hyd_name” values.

b. There is one Zi_dniw_swb feature with the name “Kariba” in the name 
(Hyd_name = “Lake Kariba:Sanyati:Sebungwe:Sengwa”). This Zi_dniw_swb 
feature has a “Uniq_id” value of 17274, so enter the value “17274” into the 
“VMAP_Link” field for the waterbody “Kariba” in your Excel table.

c. There is one Zi_dniw_swb feature with the name “Kyle” in the name (Hyd_
name = “Lake Kyle”). This Zi_dniw_swb feature has a “Uniq_id” value 
of 18135, so enter the value “18135” into the “VMAP_Link” field for the 
waterbody “Kyle” in your Excel table.

d. There are no Zi_dniw_swb features with the word “Robertson” anywhere 
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in the name.  However, with a bit of searching we can find that there is a 
Zi_dniw_swb feature named “Lake Manyame” which is very close to the 
Zi_sadc_swb point named “Manyame”, and this Zi_sadc_swb point has a 
“Comments” value of “Also known as Robertson (=Darwendale)”.  Therefore 
the polygon “Lake Manyame” is very likely the same feature as “Robertson.  
This Zi_dniw_swb feature has a “Uniq_id” value of 17608, so enter the value 
“17608” into the “VMAP_Link” field for the waterbody “Robertson” in your 
Excel table.

e. There is one Zi_dniw_swb feature with the name “McIlwaine” in the name 
(Hyd_name = “Lake Mcilwaine”). This Zi_dniw_swb feature has a “Uniq_id” 
value of 17639, so enter the value “17639” into the “VMAP_Link” field for the 
waterbody “McIlwaine” in your Excel table.

f. There are no Zi_dniw_swb features with the word “McDougall” anywhere 
in the name.  However, there is one Zi_dniw_swb feature with the word 
“MacDougall” (Hyd_name = “Lake Macdougall”), which you can find using 
the Query Builder tool  with the following search string:

( [Hyd_name].Contains(“dougall”) )

This Zi_dniw_swb feature has a “Uniq_id” value of 18167, so enter the value 
“18167” into the “VMAP_Link” field for the waterbody “McDougall” in your 
Excel table.

❑ 3. Next import your Excel table into your ArcView project and link it to your 
Zi_dniw_swb and Zi_sadc_swb attribute tables.

a. Select your data in the Excel table, then use the Import From Excel tool  
(located in your ArcView Table button bar) to import that data into a new 
ArcView table.

b. In your new imported table, click the field name “SADC_link”.

c. Open your Zi_sadc_swb attribute table and click on the field name “Nat_id”.

d. Click back on your new imported table to make it the active document, and 
then click the field name “SADC_link”.

e. Click the Join Tables button to join your SADC attributes to your table.

f. Open your Zi_dniw_swb attribute table and click on the field name “Uniq_
id”.

g. Click back on your new imported table to make it the active document, and 
then click the field name “VMAP_link”.

h. Click the Join Tables button to join your VMAP attributes to your table.

i. Save your joined table as a single dBASE table using the “Export” menu item 
in the Table “File” menu.

Exercise Summary
This exercise has demonstrated two potential methods for identifying attributes of 
waterbodies.  The first method illustrates how attributes can be extracted from nearby 
or intersecting features from separate datasets, and the second method shows how 
attribute data may be found in reports such as the SIFRA documents. The methods 
illustrated in this case study may be adapted to identify attributes of other features of 
interest, in cases where you have access to multiple datasets describing the same spatial 
phenomena.
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EXERCISE 3. Predicting potential fish yield

The purpose of this exercise is examine several methods for estimating potential fish 
yields of individual surface waterbodies.

Estimated time for completion: 1 hour

AWRD Tools  utilized

This exercise makes use of tools available in the AWRD’s Watersheds Module, Surface 
Waterbodies Module, Statistical Analysis Module, and the Additional Tools and 
Customization module, as well as data from the SIFRA Compendium references 
(Table 2.12). 

TABLE  2.12
Summary of AWRD buttons and menu items

Button Menu option Action executed

Data and Metadata Module

View: “Load 
AWRD Data…”

Load AWRD Data: this button opens the main AWRD Data Inventory dialog, 
allowing users to search for and load data layers by name or by DBC. 

Surface Waterbodies Module

AWRD Modules: 
“Open Surface 
Waterbodies 
Viewer…”

Open Surface Waterbodies Viewer: this button opens the main Surface 
Waterbodies Viewer dialog, which is the basic interface for the Surface 
Waterbodies Module. 

N/A

Potential Fish Yield  Calculator for selected SWB: this tool automatically reports 
results on Potential Fish Yield for the selected waterbody.

AWRD Modules 

“Potential 
FishYield 
Calculator…”

Potential Fish Yield Calculator : this function takes advantage of models 
developed by Halls  (1999) to predict potential yield  of a surface waterbody   in 
tonnes per year based on the surface area of the waterbody and, potentially, 
the mean  annual air temperature  of that waterbodies drainage basin.  

N/A
Select Surface Waterbodies: this tool works as the standard ArcView selection 
tool, permitting users to select features by clicking on the map.

AWRD Tools: 
“Find Location by 
Theme…”

Find Location by Theme: this tool allows you to find and zoom to particular 
features by selecting that feature from a list.

Watersheds Module

“Open Watershed 
Viewer...”

Open Watershed Viewer: Opens the Watershed Statistics Viewer dialog, 
allowing you to conduct a wide variety of analyses on watershed themes

N/A

Select Upstream and Downstream Watersheds: clicking this tool opens the 
Watershed Selection Criteria tool dialog, allowing users to select watersheds 
based on their hydrological relationship to a particular watershed  selected by 
the user.

“Change 
Watershed 
Model…”

Change Model: this function is used to change or switch analyses between 
watershed  models. This extension comes with several options (see discussion of 
Watershed Models) and provides users the ability to customize the AWRD by 
adding their own data.

Statistical Analysis 

“Field Summary 
Statistics…”

Field Summary Statistics: this function allows you to generate a wide set of 
descriptive statistics  on a theme. 

Additional Tools and Customization Module

N/A
Report GeoStats for Lines or Polygons You Select: this tool reports the length of 
line features, and the area and perimeter length of polygon features, using both 
projected and spherical coordinates.

“Add a Basemap 
Image to View...”

Add a Basemap Image to View: this tool allows you to quickly and easily add a 
background  image  to a view. These images can be very useful for both aesthetic 
and analytical purposes. 

SIFRA Compendium

N/A
Open SIFRA Data by Clicking on Country: this function can be used to open 
any country based SIFRA Compendium file for Africa by clicking over the 
appropriate country in the active View. 
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Part 1. Obtaining estimates of potential yield from reference sources

Occasionally potential yield has already been estimated for certain waterbodies.  This 
example will demonstrate how to find potential yield estimates for Lake Tanganyika in 
the Source Book for the Inland Fishery Resources of Africa (SIFRA).

Materials and methods 
Data utilized
This section primarily uses the SIFRA report on the Republic of Burundi.  The AWRD 
dataset FAO National-Ad1 Boundaries provides a useful means to help find and open 
the Burundi SIFRA file (Table 2.13).

TABLE 2.13
Summary and purpose of data used for researching existing estimates of potential yield

Name Description Filename File location Data utilization 
or purpose

Source book 
for the 
inland fishery 
resources of 
Africa Vol. 1

SIFRA Tanzania report burundi.htm [AWRD_Data]\docs\src_book\ Limnological and 
fisheries data 
to be attributed 
to Africover 
waterbodies 
data for 
Burundi.

FAO 
National-Ad1 
Boundaries

National Political 
Boundary polygons of 
Africa

Ad1_Py.shp [AWRD_Data]\avec_dbc\fao\ Help identify 
which SIFRA 
document to 
open.

Complete Table 2.14

TABLE 2.14
Lake Tanganyika potential annual fish yield

Country
(Corsi, Dunn and Felicioni, 1986)

(tonnes per year)

(Mikkola and Lindquist, 1989)

(max. tonnes per year)

Burundi

Tanzania

Democratic Republic of the Congo

Zambia

Total

Methods
Open ArcView and start the exercise by following the steps described in points 
below.

Click on the  button and load the following dataset.  You can find it 
by either typing the name or filename in the “Search Text” textbox (you may use the * 
and ? wildcard characters), or by clicking on the Additional Vector DBC and finding 
the file in the list.
❑ 1. FAO National-Ad1 Boundaries (Ad1_Py.shp); from the Additional Vector Data 

DBC.

Review the fish yield estimates for Lake Tanganyika found in the SIFRA document 
for Burundi.
❑ 1. Find Burundi in the FAO National-Ad1 Boundary theme.  If you are not 

immediately familiar with the location of Burundi, you may use the  tool to 
quickly find it.
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❑ 2. Open the SIFRA document for Burundi by using the  tool to click on 
Burundi.

❑ 3. Scroll down the SIFRA document to find the section discussing Lake 
Tanganyika.

❑ 4. Near the bottom of the discussion of Lake Tanganyika, find the record of historical 
catch, as estimated by both Corsi, Dunn and Felicioni (1986) and Mikkola amd 
Lindquist (1989).

❑ 5. Fill in Table 2.14 with the appropriate historical catch data for the four countries 
that border Lake Tanganyika. Note: The SIFRA documents were originally 
published in 1990, and therefore they refer to the Democratic Republic of the 
Congo by the old name of Zaire.

Part 2. Estimating potential yield based on historical catch data

When estimates have not already been calculated, then often the best source of data for 
estimating potential yield is the historical observed yield of that waterbody.  Naturally 
the more years of observations available, the better the estimate will be.

Materials and methods 
Data utilized
This section uses historical catch data on Nokoue Lagoon in the Republic of Benin, 
extracted from the FAO Lakes and River Fisheries Database (MRAG Ltd. 1997).  For 
comparison purposes, this section also looks at potential yield data on Nokoue Lagoon 
from the SIFRA document for Benin (Table 2.15).

TABLE 2.15
Summary and purpose of data used for estimating potential yield from historical data

Name Description Filename File location Data utilization or 
purpose

Lakes 
Fisheries 
Data

dBASE table of 
observed historical 
catch data from 
waterbodies in Africa, 
extracted from FAO 
Lakes and River 
Fisheries Database.

lakes_fisheries_data.dbf [AWRD_Data]\docs\ This file contains 
historical 
observed catch 
data for many 
waterbodies in 
Africa.

FAO 
National-
Ad1 
Boundaries

National Political 
Boundary polygons of 
Africa

Ad1_Py.shp [AWRD_Data]\
avec_dbc\fao\

Help identify 
which SIFRA 
document to 
open.

Complete Table 2.16

TABLE 2.16
Summary statistics for historic catch: Nokoue Lagoon

Mean  _____________  tonnes per year

Std. Error of Mean                    _____________  tonnes per year

Lower 95% Conf. Limit  _____________  tonnes per year

Upper 95% Conf. Limit        _____________  tonnes per year
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Methods
Open ArcView and start the exercise by following the steps described in points 
below.

Find the historical catch data for Nokoue Lagoon and estimate the mean, standard 
deviation and 95 percent confidence interval for potential yield.
❑ 1. Add the table “lakes_fisheries_data.dbf” to your ArcView project, and then open 

that table.  This table is located in the AWRD “Docs” folder.  For help with 
adding tables to ArcView, please refer to “Adding files containing tabular data to 
your project” in the ArcView help files.  Note:  This table is extracted from the 
Microsoft Access Database ZOCSRC.MDB, also located in the AWRD “Docs” 
folder.  If you wish, you can review a large amount of additional data on several 
African surface waterbodies in this Access database.

❑ 2. Use the standard ArcView query button  to select the seven records for 
Nokoue Lagoon, using the query string:

( [Wb_name] = “Nokoue” )
❑ 3. Select the field [Catch].
❑ 4. Click the AWRD Summary Statistics tool  and calculate the mean, standard 

deviation and 95 percent confidence interval for the seven selected records in the 
table.

❑ 5. Fill in the appropriate values in Table 2.16.
❑ 6. For comparison purposes, open the SIFRA document for Benin by using the 

 tool to click on Benin in your view.    If you are not immediately familiar 
with the location of Benin, you may use the  tool to quickly find it.

❑ 7. In the SIFRA document for Benin, scroll down to Table 3.  Note that the 
estimated potential annual yield for Nokoue and Porto Novo Lagoon is 6 
000 – 16 000, which is very similar to upper and lower levels of the 95 percent 
confidence interval you just calculated.

Part 3. Estimating potential yield based on waterbody characteristics
If all else fails, then potential yield may be estimated using models developed by Halls 
(1999).  Please refer to Section 1.3 of the manual for a detailed explanation of these 
models.  In general, these models identified a relationship between waterbody size, plus 
the mean air temperature in the contributing watershed, with observed yield from that 
waterbody. We can therefore use these models to predict potential yield of waterbodies 
based on size and air temperature, although the predictions are not precise.  Note:  The 
full dataset used by Halls to develop his models is included in the Access Database 
ZOCSRC.MDB, located in the AWRD “Docs” folder.

Materials and methods 
Data utilized
This section uses surface waterbody data from the dataset FAO-AquaStat 1:1m Major 
African SWBs (wria_swb.shp), and air temperature data from the FAO-AquaStat 
Major Basins Watershed Model (faoawria.shp) (Table 2.17).
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TABLE 2.17
Summary and purpose of data used for estimating potential yield from statistical models

Name Description Filename File location Data utilization or purpose

FAO-
AquaStat 
Major Basins 
Watershed 
Model

Rivers, surface 
waterbodies and 2 
level watershed model

faoawria.shp [AWRD_Data]\
ws_dbc\

Used to identify 
the region of the  
contributing watershed.

faoawria_airt.
dbf

Air Temperature 
Statistics for 
Watersheds in 
faoawria.shp 
watershed model

faoawria_airt.dbf [AWRD_Data]\
dbf_data\

Used to identify average 
air temperature in 
contributing watershed.  
Loaded automatically 
by Watershed Statistics 
Module.

FAO-
AquaStat 
1:1m Major 
African SWBs

Modified Major African 
SWBs originally from 
DCW

wria_swb.shp [AWRD_Data]\
swb_dbc\

Used to identify 
waterbody locations and 
areas.

African 
Virtual Base 
Map

1:750 000 scale 
seamless base map 
of continental Africa 
based on VMap0-Ed3, 
DCW, and Classified 
GTopo30 DEM

Vrtl_Map.sid [AWRD_Data]\
aimg_dbc\

Background reference.

FAO 
National-Ad1 
Boundaries

National Political 
Boundary polygons of 
Africa

Ad1_Py.shp [AWRD_Data]\
avec_dbc\fao\

Background reference.

Complete Table 2.18

TABLE 2.18
Potential yield for Lake Sagara, the United Republic of Tanzania, and Lake Kabamba, the 
Democratic Republic of the Congo

Lake

Waterbody 
Area

(km2)

Drainage 
basin air 

temperature

(°C)

Predicted values (using Model 1) Predicted values (using Model 2)

Potential 
fish yield 

(tonnes/
year)

95% 
Confidence 

interval

Potential 
fish yield 

(tonnes/
year)

95% 
Confidence 

interval

Lower Upper Lower Upper

Sagara

Kabamba

Methods
The AWRD offers two tools to predict potential yield using Halls’ models.  This 
exercise will demonstrate how to predict potential yield for two lakes, using a different 
method for each waterbody. Open ArcView and start the exercise by following the 
steps described in points below.

Click on the  button and load the following datasets.  You can find 
them by either typing the name or filename in the “Search Text” textbox (you may use 
the * and ? wildcard characters), or by clicking on the respective DBC and finding the 
file in the list.
❑ 1. FAO National-Ad1 Boundaries (Ad1_Py.shp); from the Additional Vector Data 

DBC.
❑ 2. FAO-AquaStat 1:1m Major African SWBs (wria_swb.shp); from the Surface 

Waterbody DBC.

Change the theme names to the short versions by clicking the “View” menu item 
“Toggle AWRD data to Short Theme Names.”  You might have to click this menu item 
two times.



Workbook 217

Ex
er

ci
se

 N
o

. 3

The remaining data will be loaded using alternative methods:
❑ 1. Click the Add Basemap button  and load the image “Vrtl_map.sid”
❑ 2. Set the watershed model to “faoawria.shp” and attach the mean air temperature 

data:
a. Click the menu “AWRD Modules”, then the menu item “Change Watershed 

Model”.
b. Select “faoawria.shp” from the list of “Available Watershed Models”.
c. Select “Mean Annual Air Temperature” from the list of “Available Data”.
d. Click ‘OK’.  If “faoawria.shp” is not already in your view, you will now be 

asked if you would like to add it to the view.  Click “Yes”.

Calculate the surface area, drainage basin air temperature and predicted yield for 
Lake Sagara:
❑ 1. Use the Find Location by Theme tool  to zoom in to Lake Sagara.  Search 

the theme “Wria_swb.shp”, and the field “Swb_name”, and use the search string 
“Sagara”.

❑ 2. Make the theme “Wria_swb.shp” active by selecting it in the View Table of 
Contents.

❑ 3. Calculate the surface area of Lake Sagara, in square kilometers, using the 
“Spatial Statistics” tool .  Enter this value in Table 2.18.

❑ 4. Open the Watershed Statistics Viewer by clicking the button .
❑ 5. Click the “Select Upstream and Downstream Watersheds” button .
❑ 6. In the “Selection Criteria” dialog, choose “Include Selected Watershed” and “All 

Upstream Watersheds”, and the option “Make New Selection”.
❑ 7. Click on Lake Sagara.  This will automatically select the watershed containing 

Lake Sagara, plus any upstream watersheds (i.e. the drainage basin).
❑ 8. In the Watershed Statistics Viewer, select “Mean Annual Air Temperature” from 

the drop-down list labeled “Select Data to Review:”
❑ 9. Find the average mean annual air temperature for the drainage basin of Lake 

Sagara and add it to Table 2.18.
❑ 10. Close the “Selection Criteria” and “Watershed Statistics Viewer” dialogs.
❑ 11. Click the “Potential Fish Yield” button  on the main AWRD 

dialog.
❑ 12. Set the Confidence Level = 0.95.
❑ 13. For model 1, enter the waterbody area from Table 2.18 and click “Calculate”.  

Enter the predicted potential yield, plus the upper and lower 95 percent 
confidence levels, into Table 2.18.

❑ 14. For model 2, enter the waterbody area and drainage basin air temperature from 
Table 2.18 and click “Calculate”.  Enter the predicted potential yield, plus the 
upper and lower 95 percent confidence levels, into Table 2.18.

Use a different method to calculate the surface area, drainage basin air temperature 
and predicted yield for Lake Kabamba.
❑ 1. Click the  button to open the Surface Waterbody Viewer.
❑ 2. Use the Find Location by Theme tool  to zoom in to Lake Kabamba.  

Search the theme “Wria_swb.shp”, and the field “Swb_name”, and use the 
search string “Kabamba”.

❑ 3. In the Surface Waterbody Viewer, make sure that “Wria_swb.shp” is selected in 
the drop-down list of available surface waterbody themes.
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❑ 4. Select Lake Kabamba using the “Select Surface Waterbodies” tool .
❑ 5. In the Surface Waterbody Viewer, make sure that “Kabamba [ID 398]” is 

selected in the list of surface waterbodies, if it is not already selected.
❑ 6. Near the bottom of the Surface Waterbody Viewer, enter a value of 0.95 in the 

“Confidence Level” text box.
❑ 7. Calculate the predicted potential yield for Lake Kabamba, using both models, 

by clicking the  button.

❑ 8. Notice that the report includes the predicted yield, the upper and lower 95 
percent confidence levels, and the calculated area of Lake Kabamba.  If you are 
using model 2, then the report also includes the drainage basin mean annual air 
temperature.  Enter these values into Table 2.18.

Exercise Summary
This exercise illustrated three methods of estimating the potential yield for a waterbody.  
In some cases you may be able to use existing estimates, assuming you are confident in 
the methodology and assumptions that produced those estimates.  If data on previous 
yield history is available, then you may make your estimate based on the average yield 
observed for that waterbody.  If no data on previous yield is available, then you may 
use Halls’ models to predict potential yield in that waterbody.
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EXERCISE 4. Preliminary hydrological reporting

The purpose of this exercise is examine several methods for identifying statistics within 
hydrological entities (i.e. watersheds or drainage basins).  

Estimated time for completion: 2 hours.  

AWRD Tools  utilized

This exercise makes use of tools available in the AWRD’s Data and Metadata Module, 
Watersheds Module, and the Additional Tools and Customization Module, as well as 
data from the SIFRA Compendium references (Table 2.19). 
  Exercise No. 4

TABLE 2.19
Summary of AWRD buttons and menu items

Button Menu option Action executed

Data and Metadata Module

View: “Load 
AWRD Data…”

Load AWRD Data: this button opens the main AWRD Data Inventory dialog, 
allowing users to search for and load data layers by name or by DBC. 

N/A
Theme: “Toggle 
AWRD Data 
Names”

Toggle AWRD to Short/Long Theme Names:  This tool changes the name of 
your dataset in your view, switching between long descriptive names and 
abbreviated names.

Watersheds Module

“Open Watershed 
Viewer...”

Open Watershed Viewer: Opens the Watershed Statistics Viewer dialog, 
allowing you to conduct a wide variety of analyses on watershed themes

“Change 
Watershed 
Model…”

Change Model: this function is used to change or switch analyses between 
watershed  models. This extension comes with several options (see 
discussion of Watershed Models) and provides users the ability to customize 
the AWRD by adding their own data.

N/A

Report: The Report button produces a text report  summarizing all the data 
currently presented on the watershed  statistics module. The report is saved 
as a text file on the hard drive and also appears in a text report on the 
screen.

AWRD Tools 
“Query Builder…”

Model Query Builder: this tool gives the user the ability to apply complex 
queries to the data to either select features or to apply a theme  definition.  
This function is described in detail in Section 1.7.

AWRD Modules 
“Simple Linear 
Regression…”

Watershed Model Regression: this tool provides a method for analysing 
linear relationships between data in watersheds, letting the user identify 
whether a dependent  variable varies in a predictable way over different 
levels of the independent  variable. This function is described in detail in 
Section 1.6.

Additional Tools and Customization Module

N/A
Report GeoStats for Lines or Polygons You Select: this tool reports the 
length of line features, and the area and perimeter length of polygon 
features, using both projected and spherical coordinates.

“Add a Basemap 
Image to View...”

Add a Basemap Image to View: this tool allows you to quickly and easily 
add a background  image  to a view. These images can be very useful for 
both aesthetic and analytical purposes. 

SIFRA Compendium

N/A
Open SIFRA Data by Clicking on Country: this function can be used to open 
any country based SIFRA Compendium file for Africa by clicking over the 
appropriate country in the active View. 



      African Water Resource Database – Technical manual and workbook220

Part 1.  Watershed statistics within the Volta River megabasin
This example will demonstrate how to search for river basin statistics within the SIFRA 
documents, and how to calculate statistics using AWRD watershed models.

Materials and methods 
Data utilized
This section uses the SIFRA report on the Republic of Ghana and the ALCOM-WWF 
watershed model to derive a wide variety of statistics on the Volta River megabasin.  
The AWRD dataset FAO National-Ad1 Boundaries provides a useful means to help 
find and open the Ghana SIFRA file (Table 2.20).

TABLE 2.20
Summary and purpose of data used to generate statistics on the Volta River megabasin

Name Description Filename File location Data utilization or 
purpose

ALCOM-WWF 
Watershed Model

A three level named 
watershed model of 
continental Africa

alcomwwf.shp [AWRD_Data]\ws_dbc\ Used to identify 
the region of 
the  contributing 
watershed.

alcomwwf_airt.
dbf

Air Temperature 
Statistics for 
Watersheds in 
alcomwwf.shp 
watershed model

alcomwwf_airt.
dbf

[AWRD_Data]\dbf_data\ Used to identify 
average air 
temperature 
in contributing 
watershed.  Loaded 
automatically by 
Watershed Statistics 
Module.

alcomwwf_prec_
ann.dbf

Precipitation 
Statistics for 
Watersheds in 
alcomwwf.shp 
watershed model

alcomwwf_
prec_ann.dbf

[AWRD_Data]\dbf_data\ Used to identify 
average precipitation  
in contributing 
watershed.  Loaded 
automatically by 
Watershed Statistics 
Module.

alcomwwf_peva_
ann.dbf

Potential Evapo-
transpiration 
Statistics for 
Watersheds in 
alcomwwf.shp 
watershed model

alcomwwf_
peva_ann.dbf

[AWRD_Data]\dbf_data\ Used to identify 
potential evapo-
transpiration 
in contributing 
watershed.  Loaded 
automatically by 
Watershed Statistics 
Module.

FAO National-Ad1 
Boundaries

National Political 
Boundary polygons 
of Africa

Ad1_Py.shp [AWRD_Data]\avec_dbc\
fao\

Help identify which 
SIFRA document to 
open.

Source book for 
the inland fishery 
resources of 
Africa Vol. 1

SIFRA Ghana report Ghana.htm [AWRD_Data]\docs\
src_book\

Limnological and 
fisheries data to be 
attributed to Africover 
waterbodies data for 
Ghana.

African Virtual 
Base Map

1:750 000 scale 
seamless base map 
of continental Africa 
based on VMap0-
Ed3, DCW, and 
Classified GTopo30 
DEM

Vrtl_Map.sid [AWRD_Data]\aimg_dbc\ Background 
reference.
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Complete Table 2.21

TABLE 2.21
Statistics on Lake Volta megabasin

Basin name
Basin size 

(km2)

Average 
annual flow 

m3/sec

Mean air 
temperature 

(º C)

Minimum 
precipitation 

(mm/yr)

Maximum 
precipitation 

(mm/yr)

Mean potential 
evapotranspiration 

(mm/yr)

Black Volta

White Volta

Oti

Volta River

Total

Methods
Open ArcView and start the exercise by following the steps described in points 
below.

❑ 1. Click on the  button and load the following dataset.  You can find 
it by either typing the name or filename in the “Search Text” textbox (you may 
use the * and ? wildcard characters), or by clicking on the Additional Vector DBC 
and finding the file in the list.

❑ 2. FAO National-Ad1 Boundaries (Ad1_Py.shp); from the Additional Vector Data 
DBC.

The remaining data will be loaded using alternative methods:
❑ 3. Click the Add Basemap button  and load the image “Vrtl_map.sid”.
❑ 4. Set the watershed model to “alcomwwf.shp” and attach the mean 

air temperature data, annual precipitation data and annual potential 
evapotranspiration data:

a. Click the menu “AWRD Modules”, then the menu item “Change Watershed 
Model”.

b. Select “alcomwwf.shp” from the list of “Available Watershed Models”.
c. Select “Annual Pot. Evapotranspiration Data”, “Annual Precipitation Data” 

and “Mean Annual Air Temperature” from the list of “Available Data”.
d. Click ‘OK’.  If “alcomwwf.shp” is not already in your view, you will now be 

asked if you would like to add it to the view.  Click “Yes”.

Change the theme names to the short versions by clicking the “View” menu item 
“Toggle AWRD data to Short Theme Names.”  You might have to click this menu item 
two times.

Look up the average annual flow, in m3/sec, for each basin listed in Table 2.21:
❑ 5. Find Ghana in the FAO National-Ad1 Boundary theme.
❑ 6. Open the SIFRA document for Ghana by using the  tool to click on Ghana.
❑ 7. Look in Section 6 (Waterbodies Directory) for mean annual flow of the Black 

Volta, White Volta, Oti and Lower Volta basins.  Add these values to Table 2.21.
❑ 8. Look in Section 2.2 (Rivers, Floodplains and Swamps) for information on the 

average annual flow of the Volta river in general.  Add this value to the “Total” 
row in Table 2.21. 

Calculate the Basin Size, Mean Air Temperature, Minimum and Maximum Precipitation, 
and the Mean Potential Evapotranspiration for each basin listed in Table 2.21.
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❑ 9. Open the Watershed Statistics Viewer by clicking the button .
❑ 10. Select all watersheds in the Black Volta basin using the Query button .  

The query string should be as follows:
( [Basin_name] = “Black Volta” )

❑ 11. The area of the Black Volta basin, in square kilometers, is near the top of the 
Watershed Statistics Viewer dialog.  Add this value to Table 2.21.

❑ 12. Click the “Select Data to Review” dropdown list to choose between Mean 
Annual Air Temperature, Annual Precipitation Data, and Annual Pot. 
Evapotranspiration Data.  Add the appropriate values to Table 2.21.

❑ 13. Select all watersheds in the White Volta basin using the following query string:
( [Basin_name] = “White Volta” )

❑ 14. Add the White Volta basin statistics to Table 2.21.
❑ 15. Select all watersheds in the Oti basin using the following query string:

( [Basin_name] = “Oti” )
❑ 16. Add the Oti basin statistics to Table 2.21. 
❑ 17. Select all watersheds in the Volta River basin using the following query string:

( [Basin_name] = “Volta River” )
❑ 18. Add the Volta River basin statistics to Table 2.21. 
❑ 19. Select all watersheds in all four of the basins in Table 2.21 using the following 

query string:
 ( [Basin_name] = “Black Volta” )  OR ( [Basin_name] = “White Volta” ) OR ( 

[Basin_name] = “Oti” ) OR ( [Basin_name] = “Volta River” )
❑ 20. Add the Total basin statistics to Table 2.21.

Extra Exercise:  Visualizing watershed attributes

While your watershed model alcomwwf.shp is in your view, and the datasets “Annual 
Pot. Evapotranspiration Data”, “Annual Precipitation Data” and “Mean Annual Air 
Temperature” are joined to the model, you may display the model according to values 
in those datasets:

❑ 1. Click on alcomwwf.shp in the View table of contents and drag it to the top.  Make 
sure it is visible and that it is the only active theme.

❑ 2. Use the standard ArcView Zoom to Active Theme button  to zoom to the 
extent of alcomwwf.shp.

❑ 3. Double-click the theme alcomwwf.shp in the table of contents to open the legend 
editor.

❑ 4. Set “Legend Type” = “Graduated Color”

❑ 5. Set “Classification Field” = “Peva_mean”.  This will display the watershed 
model according to the mean annual potential evapotranspiration values for each 
watershed.

❑ 6. Click the “Classify” button and set the Number of Classes = 10.

❑ 7. Set the color ramp = “Blues to Reds dichromatic”

❑ 8. Close the Legend Editor.

❑ 9. Click the “Theme” menu, then “Adjust Polygon Border and Pattern”

❑ 10. Click the option “Do Not Use Outline”, and then click ‘OK’.



Workbook 223

Ex
er

ci
se

 N
o

. 4

❑ 11. Repeat steps 5 – 10 for classification fields “airt_mean” (mean annual air 
temperature) and “aprec_mean” (mean annual precipitation).  Experiment with 
different numbers of classes and with different color ramps.

Part 2:  Summary statistics for the Republic of Ghana and Burkina Faso

The AWRD Watershed Statistics Viewer can be used to generate statistics on any 
registered polygon theme.  This exercise illustrates how the Watershed Statistics Viewer 
can be used to calculate a large variety of statistics for the Republic of Ghana and 
Burkina Faso.

Materials and methods 
Data utilized
This section uses the Vmap0 Subnational Ad2 polygon shapefile to derive a wide 
variety of statistics for the Republic of Ghana and Burkina Faso (Table 2.22).

TABLE 2.22
Summary and purpose of data used to generate statistics for the Republic of Ghana and 
Burkina Faso

Name Description Filename File location Data utilization or 
purpose

VMap0 
Subnational-
Ad2 Polygonal 
Boundaries

Coastal, national, 
subnational and 
sovereign boundary 
data layers derived 
from VMap0-Ed5.

Ad2_Py.shp [AWRD_Data]\ avec_
dbc\vmap0\

Subnational political 
boundary file 
registered with the 
Watershed Statistics 
Viewer.

ad2_py_elev.dbf Elevation Statistics 
for polygons in Ad2_
Py.shp administrative 
boundary shapefile.

ad2_py_elev.
dbf

[AWRD_Data]\dbf_data\ Used to identify 
elevations in 
administrative 
boundary polygons.  
Loaded automatically 
by Watershed 
Statistics Module.

ad2_py_prec.dbf Monthly Precipitation 
Statistics for 
polygons in Ad2_
Py.shp administrative 
boundary shapefile.

ad2_py_prec.
dbf

[AWRD_Data]\dbf_data\ Used to identify 
monthly precipitation 
in administrative 
boundary polygons.  
Loaded automatically 
by Watershed 
Statistics Module.

ad2_py_pop2k.dbf Potential Density 
Statistics for 
polygons in Ad2_
Py.shp administrative 
boundary shapefile.

ad2_py_pop2k.
dbf

[AWRD_Data]\dbf_data\ Used to identify 
population densities 
in administrative 
boundary polygons.  
Loaded automatically 
by Watershed 
Statistics Module.

ad2_py_peva_ann.
dbf

Potential Evapo-
transpiration 
Statistics for 
polygons in Ad2_
Py.shp administrative 
boundary shapefile.

ad2_py_peva_
ann.dbf

[AWRD_Data]\dbf_data\ Used to identify 
mean annual 
potential evapo-
transpiration in 
administrative 
boundary polygons.  
Loaded automatically 
by Watershed 
Statistics Module.

ad2_py_air_
month.dbf

Monthly Air 
Temperature 
Statistics for 
polygons in Ad2_
Py.shp administrative 
boundary shapefile.

ad2_py_air_
month.dbf

[AWRD_Data]\dbf_data\ Used to identify 
monthly air 
temperatures in 
administrative 
boundary polygons.  
Loaded automatically 
by Watershed 
Statistics Module.

2.5d Enhanced 
NASA Blue Marble 
30 as Mosaic

2.5d enhanced 
version of NASA 
Blue-Marble mosaic

BluMrbl_Shd.
jp2

[AWRD_Data]\aimg_
dbc\

Background 
reference.
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Complete Table 2.23

TABLE 2.23
Statistics on the Republic of Ghana and Burkina Faso

Statistics Ghana Burkina Faso

Area (km2)

Mean annual potential evapotranspiration

Elevation mean

Elevation minimum

Elevation maximum

Mean annual air temperature (º C)

Mean January air temperature (º C)

Mean February air temperature (º C)

Mean March air temperature (º C)

Mean April air temperature (º C)

Mean May air temperature (º C)

Mean June air temperature (º C)

Mean July air temperature (º C)

Mean August  air temperature (º C)

Mean September air temperature (º C)

Mean October air temperature (º C)

Mean November air temperature (º C)

Mean December air temperature (º C)

Mean Annual precipitation  (mm/yr)

Mean January precipitation  (mm/yr)

Mean February precipitation  (mm/yr)

Mean March precipitation  (mm/yr)

Mean April  precipitation  (mm/yr)

Mean May precipitation  (mm/yr)

Mean June precipitation  (mm/yr)

Mean July precipitation  (mm/yr)

Mean August precipitation  (mm/yr)

Mean September precipitation  (mm/yr)

Mean October precipitation  (mm/yr)

Mean November precipitation  (mm/yr)

Mean December precipitation  (mm/yr)

2000 Population density mean

2000 Population density minimum

2000 Population maximum
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Methods
Open ArcView and start the exercise by following the steps described in points 
below.
❑ 1. Click the Add Basemap button  and load the image “BluMrbl_Shd.jp2”.  

Note:  If this image looks extremely pixilated, try zooming out to the full extent 
of the view using the standard ArcView Zoom to Full Extent button , and 
then back to your original extent using the standard ArcView Zoom to Previous 
Extent button .  This usually fixes the pixilation problem.

❑ 2. Set the watershed model to “Ad2_Py.shp” and attach the elevation data, 2000 
population density data, monthly air temperature data, monthly precipitation 
data and annual potential evapotranspiration data:
a. Click the menu “AWRD Modules”, then the menu item “Change 

Watershed Model”.
b. Select “Ad2_Py.shp” from the list of “Available Watershed Models”.
c. Select “Annual Pot. Evapotranspiration Data”, “Elevation Data (SRTM_

GT30)”, “Monthly Air Temperature Data”, “Monthly Precipitation Data” 
and “Population Density 2000” from the list of “Available Data”.

d. Click ‘OK’.  If “Ad2_Py.shp” is not already in your view, you will now be 
asked if you would like to add it to the view.  Click “Yes”.

Calculate statistics for the Republic of Ghana and Burkina Faso.
❑ 1. Open the Watershed Statistics Viewer by clicking the button .
❑ 2. Select all subnational polygons in Ghana using the Query button .  The 

query string should be as follows:
( [Na2_descri] = “Ghana” )

❑ 3. Click the Report button  to see all the statistics in a single report.
❑ 4. Add the statistics for Ghana to Table 2.23.
❑ 5. Select all subnational polygons in Burkina Faso using the Query button .  

The query string should be as follows:
( [Na2_descri] = “Burkina Faso” )

❑ 6. Click the Report button  to see all the statistics in a single report.
❑ 7. Add the statistics for Burkina Faso to Table 2.23.

Part 3:  Regression analysis in Volta megabasin
This exercise demonstrates how to perform a simple regression analysis on watershed 
data, in order to search for potential relationships between Mean Annual Air 
Temperature vs. Elevation, and Mean Annual Potential Evapotranspiration vs. Mean 
Annual Precipitation in the Volta Megabasin.

Materials and methods 
Data utilized
This section uses the ALCOM-WWF watershed model to derive statistics on the Volta 
River megabasin (Table 2.24).
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TABLE 2.24
Summary and purpose of data used to generate statistics on the Volta River megabasin

Name Description Filename File location Data utilization or 
purpose

ALCOM-WWF 
Watershed Model

A three level named 
watershed model of 
continental Africa

alcomwwf.shp [AWRD_Data]\ws_dbc\ Used to identify 
the region of 
the  contributing 
watershed.

alcomwwf_airt.
dbf

Air Temperature 
Statistics for 
Watersheds in 
alcomwwf.shp 
watershed model

alcomwwf_
airt.dbf

[AWRD_Data]\dbf_data\ Used to identify 
average air 
temperature 
in contributing 
watershed.  Loaded 
automatically by 
Watershed Statistics 
Module.

alcomwwf_prec_
ann.dbf

Precipitation Statistics 
for Watersheds 
in alcomwwf.shp 
watershed model

alcomwwf_
prec_ann.dbf

[AWRD_Data]\dbf_data\ Used to identify 
average 
precipitation  in 
contributing 
watershed.  Loaded 
automatically by 
Watershed Statistics 
Module.

alcomwwf_peva_
ann.dbf

Potential Evapo-
transpiration Statistics 
for Watersheds 
in alcomwwf.shp 
watershed model

alcomwwf_
peva_ann.dbf

[AWRD_Data]\dbf_data\ Used to identify 
potential evapo-
transpiration 
in contributing 
watershed.  Loaded 
automatically by 
Watershed Statistics 
Module.

alcomwwf_elev.
dbf

Elevation Statistics 
for Watersheds 
in alcomwwf.shp 
watershed mode

alcomwwf_
elev.dbf

[AWRD_Data]\dbf_data\ Used to identify 
average elevation  
in contributing 
watershed.  Loaded 
automatically by 
Watershed Statistics 
Module.

2.5d Enhanced 
NASA Blue Marble 
30 as Mosaic

2.5d enhanced version 
of NASA Blue-Marble 
mosaic

BluMrbl_Shd.
jp2

[AWRD_Data]\aimg_dbc\ Background 
reference.

Complete Table 2.25

TABLE 2.25
Regression analysis on Lake Volta megabasin

Regression analysis:  mean annual air temperature vs. elevation

Independent variable

Dependent variable

Regression equation

R-Squared

P-Value

Upper 95% confidence level for slope

Lower 95% confidence level for slope

Mean annual air temperature

Standard deviation of air temperature

Mean elevation

Standard deviation of elevation

Number of rows
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Regression analysis:  mean potential evapotranspiration vs. mean annual precipitation

Independent variable

Dependent variable

Regression equation

R-Squared

P-Value

Upper 95% confidence level for slope

Lower 95% confidence level for slope

Mean annual air temperature

Standard deviation of air temperature

Mean elevation

Standard deviation of elevation

Number of rows

Methods
Open ArcView and start the exercise by following the steps described in points 
below.
❑ 1. Click the Add Basemap button  and load the image “BluMrbl_Shd.jp2”.  

Note:  If this image looks extremely pixilated, try zooming out to the full extent 
of the view using the standard ArcView Zoom to Full Extent button , and 
then back to your original extent using the standard ArcView Zoom to Previous 
Extent button .  This usually fixes the pixilation problem.

❑ 2. Set the watershed model to “alcomwwf.shp” and attach the elevation data, 
mean air temperature data, annual precipitation data and annual potential 
evapotranspiration data:
a. Click the menu “AWRD Modules”, then the menu item “Change 

Watershed Model”.
b. Select “alcomwwf.shp” from the list of “Available Watershed Models”.
c. Select “Annual Pot. Evapotranspiration Data”, “Elevation Data (SRTM_

Gt30)”, “Annual Precipitation Data” and “Mean Annual Air Temperature” 
from the list of “Available Data”.

d. Click ‘OK’.  If “alcomwwf.shp” is not already in your view, you will now 
be asked if you would like to add it to the view.  Click “Yes”.

Select the watersheds in the primary Volta megabasin.
❑ 1. Open the Watershed Statistics Viewer by clicking the button .
❑ 2. Select all watersheds in the primary Volta megabasin using the following query 

string:
 ( [Basin_name] = “Black Volta” )  OR ( [Basin_name] = “White Volta” ) OR ( 

[Basin_name] = “Oti” ) OR ( [Basin_name] = “Volta River” )

Perform a regression analysis to look for a linear relationship between mean annual air 
temperature and mean elevation within the Volta megabasin.
❑ 1. Click the Regression button  on the Watershed Statistics Viewer.
❑ 2. Set the Theme = “Alcomwwf.shp”
❑ 3. Set the Independent Variable = “Elev_mean” (for Mean Elevation)
❑ 4. Set the Dependent Variable = “Airt_mean” (for Mean Annual Air Temperature)
❑ 5. Check the “Descriptive Statistics” box.  Click the “Options” button and select 

“Mean”, “Standard Deviation” and “Number of Rows”
❑ 6. Check “Confidence Interval for Slope” and enter a confidence level of “0.95”
❑ 7. Check “R-Squared”
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❑ 8. Check “ANOVA Table”
❑ 9. Check “Scatterplot”
❑ 10. Click ‘OK’ to generate the regression report and scatterplot.
❑ 11. All the values to be entered in Table 2.25 are available on the regression report.  

Enter the values on Table 2.25.

Repeat this regression analysis to look for a linear relationship between mean annual 
precipitation and mean annual potential evapotranspiration.  In this case, use “Aprec_
mean” as the Independent Variable and “Peva_mean” as the Dependent Variable.  Enter 
the appropriate values into Table 2.25.

Part 4:  Compare Lake Volta statistics from multiple sources
This example will demonstrate how different data sources may have different values for 
the same object, as illustrated by six sources of surface area for Lake Volta.

Materials and methods 
Data utilized
This section uses the SIFRA report on the Republic of Ghana, the ALCOM-WWF 
watershed model, and four surface waterbody themes to derive surface area values for 
Lake Volta.  The AWRD dataset FAO National-Ad1 Boundaries provides a useful 
means to help find and open the Ghana SIFRA file (Table 2.26).

TABLE 2.26
Summary and purpose of data used to generate statistics on the Volta River megabasin

Name Description Filename File location Data utilization or 
purpose

ALCOM-WWF 
Watershed 
Model

A three level named 
watershed model of 
continental Africa.

alcomwwf.
shp

[AWRD_Data]\ws_dbc\ Surface Area of Lake 
Volta.

Harmonized 
DCW-VMap0 
Surface Water 
Bodies

Seamless and 
topologically robust 
derivative of source 
DCW and VMap0 
perennial/non-perennial 
SWBs from VMAP0-
IW, DCW-DNNET and 
DCW-LCPOLY sources.

dniw_hyd.shp [AWRD_Data]\swb_dbc\ Surface Area of Lake 
Volta.

RWDB2 Surface 
Water Bodies

Enhanced SWB 
polygonal derivative 
based on 4 separate 
RWDB2 Library layers.

RWDB_SWB-
Py.shp

[AWRD_Data]\avec_
dbc\rwdb2\

Surface Area of Lake 
Volta.

SRTM River-
Surface Water 
Bodies

Highest resolution 
waterbody and coastal 
mask of Africa.

swbd_py.shp [AWRD_Data]\swb_dbc\ Surface Area of Lake 
Volta.

Consolidated 
VMap0 Surface 
Water-Hydro 
Features

Harmonized VMap0  
and DCW-named-SWB 
features.

vmap_py.shp [AWRD_Data]\swb_dbc\ Surface Area of Lake 
Volta.

FAO National-
Ad1 Boundaries

National Political 
Boundary polygons of 
Africa

Ad1_Py.shp [AWRD_Data]\swb_dbc\ Help identify which 
SIFRA document to 
open.

Source book for 
the inland fishery 
resources of 
Africa Vol. 1

SIFRA Ghana report Ghana.htm [AWRD_Data]\docs\
src_book\

Limnological and 
fisheries data to be 
attributed to Africover 
waterbodies data for 
Ghana.

2.5d Enhanced 
NASA Blue 
Marble 30 as 
Mosaic

2.5d enhanced version 
of NASA Blue-Marble 
mosaic

BluMrbl_Shd.
jp2

[AWRD_Data]\aimg_
dbc\

Background reference.
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Complete Table 2.27 

TABLE 2.27
Lake Volta area values from multiple sources

Source Area of Lake Volta (km2)

alcomwwf.shp

SIFRA Document for Ghana

rwdb_swb-py.shp

swbd_py.shp

dniw_hyd.shp

vmap_py.shp1

1Note that Lake Volta from vmap_py.shp includes three polygons.

Methods
Open ArcView and start the exercise by following the steps described in points 
below.

Click on the  button and load the following datasets.  You can find 
them by either typing the name or filename in the “Search Text” textbox (you may use 
the * and ? wildcard characters), or by clicking on the respective DBC and finding the 
file in the list.
❑ 1. FAO National-Ad1 Boundaries (Ad1_Py.shp); from the Additional Vector Data 

DBC.
❑ 2. ALCOM-WWF Watershed Model (alcomwwf.shp); from the Watersheds DBC.
❑ 3. RWDB2 Surface Water Bodies (RWDB_SWB-Py.shp); from the Surface Waterbody 

DBC.
❑ 4. SRTM River-Surface Water Bodies (swbd_py.shp); from the Surface Waterbody 

DBC.
❑ 5. Harmonized DCW-VMap0 Surface Water Bodies (dniw_hyd.shp); from the 

Surface Waterbody DBC. 
❑ 6. Consolidated VMap0 Surface Water-Hydro Features (vmap_py.shp); from the 

Surface Waterbody DBC.

The remaining data will be loaded using an alternative method:
❑ 1. Click the Add Basemap button  and load the image “BluMrbl_Shd.jp2”.  

Note:  If this image looks extremely pixilated, try zooming out to the full extent 
of the view using the standard ArcView Zoom to Full Extent button , and 
then back to your original extent using the standard ArcView Zoom to Previous 
Extent button .  This usually fixes the pixilation problem.

Change the theme names to the short versions by clicking the “View” menu item 
“Toggle AWRD data to Short Theme Names.”  You might have to click this menu item 
two times.

Open the SIFRA document for Ghana and look up the area, in km2, for Lake Volta:
❑ 1. Find Ghana in the FAO National-Ad1 Boundary theme.
❑ 2. Open the SIFRA document for Ghana by using the  tool to click on Ghana.
❑ 3. Look in Table 2 (Morphological Data for Major Lakes, Reservoirs and Lagoons) 

for the area of Lake Volta.  Add this value to Table 2.27.

Calculate the area, in km2, for Lake Volta using the remaining five data sources.

❑ 1. Make alcomwwf.shp active by clicking on it in the View Table of Contents.
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❑ 2. Calculate the area in km2 for Lake Volta by clicking on it with the Report 
Descriptive Spatial Statistics tool .  Add this value to the alcomwwf.shp row 
in Table 2.27. 

❑ 3. Make dniw_hyd.shp active by clicking on it in the View Table of Contents.

❑ 4. Calculate the area in km2 for Lake Volta by clicking on it with the Report 
Descriptive Spatial Statistics tool .  Add this value to the dniw_hyd.shp row 
in Table 2.27. 

❑ 5. Make rwdb_swb-py.shp active by clicking on it in the View Table of Contents.

❑ 6. Calculate the area in km2 for Lake Volta by clicking on it with the Report 
Descriptive Spatial Statistics tool .  Add this value to the rwdb_swb-py.shp 
row in Table 2.27.

❑ 7. Make swbd_py.shp active by clicking on it in the View Table of Contents.

❑ 8. Calculate the area in km2 for Lake Volta by clicking on it with the Report 
Descriptive Spatial Statistics tool .  Note:  This action may take longer with 
this theme than with the previous themes because this dataset has a very high-
resolution border for Lake Volta.  Add this area value to the swbd_py.shp row in 
Table 2.27.

❑ 9. Make vmap_py.shp active by clicking on it in the View Table of Contents.

❑ 10. Vmap_py.shp does not include the entire area of Lake Volta in a single polygon.  
This dataset breaks Lake Volta up into three separate regions.  These regions are 
easier to distinguish if you add polygon borders to the theme:

a. Click the “Theme” menu, then “Adjust Polygon Border and Pattern”

b. Click the option “Use Outline”.

c. Click the option “Constant Outline Color”.

d. Click the “Set Color” button and choose a dark color.

e. Set the “Outline Width” = 0.1

f. Click ‘OK’.

g. Zoom into the southern portion of Lake Volta to see the three separate 
regions.

❑ 11. Identify the three polygons that make up Lake Volta and use the Report 
Descriptive Spatial Statistics tool  to calculate the area in km2 for each of 
them.  Add up the three area values and enter the total to the vmap_py.shp row 
in Table 2.27.

Exercise Summary
This exercise illustrates several ways to generate statistics on watersheds, waterbodies 
and other polygons using tools from the AWRD toolset.  In particular, Part 4 of the 
exercise illustrates the fact that different data sources can lead to different statistical 
results on the same feature.  In a case like this, it is often a good idea to look at the 
metadata for the data source, to determine the age of the data and the scale at which it 
was digitized or created.  
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EXERCISE 5. Invasive and introduced aquatic species

The purpose of this exercise is explore how the AWRD tools can be used for identifying 
potential habitat for aquatic species, and predicting where introduced species might 
distribute themselves.

Estimated time for completion: 2 hours

AWRD tools  utilized

This exercise makes use of tools available in the AWRD’s Data and Metadata Module, 
Aquatic Species Module, Watersheds Module, Statistical Analysis Module and the 
Additional Tools and Customization Module (Table 2.28). 

TABLE  2.28
Summary of AWRD buttons and menu items

Button Menu option Action executed

Data and Metadata Module

View: “Load 
AWRD Data…”

Load AWRD Data: this button opens the main AWRD Data Inventory dialog, 
allowing users to search for and load data layers by name or by DBC. 

N/A
Theme: “Toggle 
AWRD Data 
Names”

Toggle AWRD to Short/Long Theme Names:  This tool changes the name of 
your dataset in your view, switching between long descriptive names and 
abbreviated names.

Aquatic Species Module

“Open Aquatic 
Species  
Viewer…”

Open Aquatic Species Viewer: opens the main Aquatic Species dialog, 
with tools to view the known distributions of aquatic species,  to identify 
species within a particular area, and to easily review data and pictorial 
representations of different species.

“Link to FishBase 
Web Site…”

Links user directly to the FishBase website, allowing searches for of over 28 
000 species of fish.

Watersheds Module

“Open 
Watershed 
Viewer...”

Open Watershed Viewer: Opens the Watershed Statistics Viewer dialog, 
allowing you to conduct a wide variety of analyses on watershed themes

“Change 
Watershed 
Model…”

Change Model: this function is used to change or switch analyses between 
watershed  models. This extension comes with several options (see discussion 
of Watershed Models) and provides users the ability to customize the AWRD 
by adding their own data.

“Select 
Relationship 
with Another 
Theme”

Select by Relationship with Another Theme: clicking this tool opens the 
“Select Watersheds by Other Themes” dialog, allowing users to select 
watersheds based on their hydrological and/or spatial relationship to selected 
features in another theme. 

N/A

Select Upstream and Downstream Watersheds: clicking this tool opens the 
Watershed Selection Criteria tool dialog, allowing users to select watersheds 
based on their hydrological relationship to a particular watershed  selected by 
the user.

Statistical Analysis Module

“Classify Theme 
by Multiple 
Criteria…”

Classify Theme by Multiple Criteria: this function allows you to classify 
features in a theme  based on complex criteria, and to save the criteria sets for 
use with other datasets.

“Query 
Builder...”

Query Builder: this tool provides a comprehensive way to either select or view 
features in a theme  based on a complex query to the feature attribute table.

Additional Tools and Customization Module

“Find Location 
by Theme...”

Find Location by Theme: this tool allows you to find and zoom  to particular 
features by selecting that feature from a list.

“Select by 
Theme...”  

Select by Theme: this tool provides a means to select features from one 
theme  that have some type of proximity relationship (i.e. intersect with, 
are contained by, are within distance of, etc.) with the selected features of 
another theme.

“Add a Basemap 
Image to 
View...”

Add a Basemap Image to View: this tool allows you to quickly and easily add 
a background  image  to a view. These images can be very useful for both 
aesthetic and analytical purposes. 
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Part 1:  Potential distribution of North African Catfish, based on FishBase 
locations and alcomwwf.shp watersheds
This exercise will illustrate how to import data from FishBase and analyze potential 
habitat using those locations in conjunction with a watershed model.  This exercise 
does not include a table in the workbook to fill out.  Rather, the exercise is to generate a 
point shapefile of catfish locations, and then generate shapefiles of catfish distributions 
and potential distributions.

Materials and methods 
Data utilized
This section uses the ALCOM-WWF watershed model in conjunction with downloaded 
sharptooth catfish locations to identify the potential distribution of this species.  The 
background image SRTM30_ShdBath.jp2 provides a spatial reference (Table 2.29).

TABLE 2.29
Summary and purpose of data used

Name Description Filename File location Data utilization or 
purpose

ALCOM-WWF 
Watershed Model

A three level named 
watershed model of 
continental Africa

alcomwwf.
shp

[AWRD_Data]\ws_dbc\ Used to identify 
the region of 
the  contributing 
watershed.

Sharptooth 
Catfish Locations

Set of coordinates for 
observed sharptooth 
catfish locations, 
downloaded from 
FishBase

N/A http://www.fishbase.
org/Summary/
SpeciesSummary.
php?id=1934

Used to identify 
watersheds in which 
sharptooth catfish 
have been observed.

Color Shade 
of SRTM30as 
w/ETopo2 
Bathymetry

2.5d enhanced 
RGB image of 
SRTM-30 terrestrial 
elevation and ETopo2 
bathymetric data

SRTM30_
ShdBath.jp2

[AWRD_Data]\aimg_dbc\ Background 
reference.  

Methods
Open ArcView and start the exercise by following the steps below.

Click the Aquatic Species Viewer button  to open up the Aquatic Species 
Distribution view and the associated Aquatic Species Viewer dialog.

Download locations for Sharptooth Catfish from FishBase:
❑ 1. In the Aquatic Species Viewer, choose the option to list aquatic species by 

Common Name, and then find and select “Sharptooth Catfish” in the list of 
species.

❑ 2. With “Sharptooth Catfish” selected, click the button “Link to FishBase” 
.

❑ 3. While at the FishBase Web site for Sharptooth Catfish, scroll down to the section 
titled “Tools” near the bottom and click the link to “Biogeographic Modelling”.

❑ 4. You should see two list boxes at the bottom of the “Biogeographic Modelling 
Tools” page.  The one on the right has a button named “Select All” above it.  Click 
that button to select all the sharptooth catfish coordinates in the listbox.

❑ 5. Click [CONTROL]-C to copy that list to the computer memory.
❑ 6. Return to ArcView and open a blank script.
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❑ 7. Either click the standard ArcView “Paste” button , or simply click 
[CONTROL]-V, to paste the list into your blank script window.

❑ 8. Click the “Convert Text to Point Shapefile” button  in the Script Button Bar 
(Note:  This button has the same picture as the “Open Aquatic Species Viewer” 
button on the main AWRD dialog, but it is not the same button).

❑ 9. You will be asked what to name your new point shapefile (this example will 
assume the name “catfish.shp”), and whether you would like to add it to a view.  
Choose the option to “Make New View”.

❑ 10. Close your script window containing the list of location coordinates.  You may 
delete this script document if you like.

Add additional data:
❑ 1. Set the watershed model to “alcomwwf.shp”:

a. Click the menu “AWRD Modules”, then the menu item “Change 
Watershed Model”.

b. Select “alcomwwf.shp” from the list of “Available Watershed Models”.
c. This exercise does not require any additional data.  You may select any of 

the additional datasets if you wish, or none of them.
d. Click ‘OK’.  If “alcomwwf.shp” is not already in your view, you will now 

be asked if you would like to add it to the view.  Click “Yes”.
❑ 2. Click the Add Basemap button  and load the image “SRTM30_ShdBath.

jp2”.  Note:  If this image looks extremely pixilated, try zooming out to the full 
extent of the view using the standard ArcView Zoom to Full Extent button 
, and then back to your original extent using the standard ArcView Zoom to 
Previous Extent button .  This usually fixes the pixilation problem.

Change the theme names to the short versions by clicking the “View” menu item 
“Toggle AWRD data to Short Theme Names.”  You might have to click this menu item 
two times.

Identify watersheds that contain observed FishBase catfish locations:
❑ 1. Select all of your catfish locations by opening the catfish.shp attribute table with 

the  button, then clearing any current selection with the  button, and 
finally selecting all locations with the Switch Selection button .

❑ 2. Click back on your view to make it active.
❑ 3. Click the “Select by Relationship with Another Theme” button  to open 

the watershed theme selection dialog.
❑ 4. Use the dialog to selection the alcomwwf.shp polygons that intersect with the 

combined features of your selected catfish.shp locations.
❑ 5. Save this subset of selected alcomwwf.shp watershed polygons to a new 

shapefile:
a. Click on the alcomwwf.shp theme in the View Table of Contents to make 

it the active theme.
b. Click the “Convert to Shapefile” menu item in the “Theme” menu
c. When asked, say “Yes” to add the new theme to your view.
d. If you wish to clear the black polygon borders surrounding each watershed 

polygon, click the “Theme” menu, then “Adjust Polygon Border and 
Pattern”, then choose the option “Do Not Use Outline”, and then click 
‘OK’. 
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❑ 6. Your new shapefile represents the observed distribution of sharptooth catfish, 
based on observed locations from FishBase.

Optional Exercise:  Identify watersheds that either intersect or lie up or downstream 
of the observed FishBase catfish locations:  Warning:  This optional exercise is not 
difficult, but it will take the computer much longer to process the steps.  Plan for 10-
20 minutes of computer processing time to complete this exercise.
❑ 1. Select all of your catfish.shp locations by opening the catfish attribute table with 

the  button, then clearing any current selection with the  button, and 
finally selecting all locations with the Switch Selection button .

❑ 2. Click the “Select by Relationship with Another Theme” button  to open 
the watershed theme selection dialog.

❑ 3. Use the dialog to selection the alcomwwf.shp polygons that intersect with the 
combined features of your selected catfish.shp locations.  Choose both of the 
options “Include Upstream polygons” and “Include Downstream Polygons”.  
This query will take much longer to process than the last query because it has 
to search through the hydrological network to identify all watersheds that are 
upstream and downstream of all the catfish locations. 

❑ 4. Save this subset of selected alcomwwf.shp watershed polygons to a new 
shapefile:
a. Click on the alcomwwf.shp theme in the View Table of Contents to make 

it the active theme.
b. Click the “Convert to Shapefile” menu item in the “Theme” menu
c. When asked, say “Yes” to add the new theme to your view.
d. If you wish to clear the black polygon borders surrounding each watershed 

polygon, click the “Theme” menu, then “Adjust Polygon Border and 
Pattern”, then choose the option “Do Not Use Outline”, and then click 
‘OK’. 

❑ 5. Your new shapefile represents the potential distribution of sharptooth catfish, 
based on observed locations from FishBase.

Part 2:  Potential distribution of common carp in SADC region, based on 
aquatic species locations and alcomwwf.shp watersheds
The ICES Code of Practice on the Introductions and Transfers of Marine Organisms 
(ICES, 2004) and the FAO Code of Conduct for Responsible Fisheries (FAO 1995) 
call upon agencies to notify responsible authorities in states that may be impacted by 
introductions of non-native species. This exercise will demonstrate how to identify 
areas that might be affected by introduction of an invasive species.
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Materials and methods 
Data utilized
This section uses the ALCOM-WWF watershed model to define the hydrological 
network, and the FAO National-Ad1 Boundaries to identify what countries are 
intersected by the downstream watersheds. The background image SRTM30_ShdBath.
jp2 provides a spatial reference (Table 2.30).

TABLE 2.30
Summary and purpose of data used

Name Description Filename File location Data utilization or 
purpose

ALCOM-WWF 
Watershed 
Model

A three level named 
watershed model of 
continental Africa

alcomwwf.shp [AWRD_Data]\ws_dbc\ Used to identify 
the region of 
the  contributing 
watershed.

FAO National-
Ad1 Boundaries

National Political 
Boundary polygons of 
Africa

Ad1_Py.shp [AWRD_Data]\avec_dbc\
fao\

Identify which 
countries lie 
downstream from a 
particular watershed

Color Shade 
of SRTM30as 
w/ETopo2 
Bathymetry

2.5d enhanced 
RGB image of 
SRTM-30 terrestrial 
elevation and ETopo2 
bathymetric data

SRTM30_
ShdBath.jp2

[AWRD_Data]\aimg_dbc\ Background reference.  

Answer the question below.

What downstream countries should be alerted if an invasive species were released into 
the Lukanga watershed in the Republic of Zambia?

1) ________________________________

2) ________________________________

3) ________________________________

Methods
Open ArcView and start the exercise by following the steps below.

Open a new view and the spatial data:
❑ 1. Set the watershed model to “alcomwwf.shp”:

a. Click the menu “AWRD Modules”, then the menu item “Change 
Watershed Model”.

b. Select “alcomwwf.shp” from the list of “Available Watershed Models”.
c. This exercise does not require any additional data.  You may select any of 

the additional datasets if you wish, or none of them.
d. Click ‘OK’.  If “alcomwwf.shp” is not already in your view, you will now 

be asked if you would like to add it to the view.  Click “Yes”.
❑ 2. Click the Add Basemap button  and load the image “SRTM30_ShdBath.jp2”.  

Note:  If this image looks extremely pixilated, try zooming out to the full extent 
of the view using the standard ArcView Zoom to Full Extent button , and 
then back to your original extent using the standard ArcView Zoom to Previous 
Extent button .  This usually fixes the pixilation problem.
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❑ 3. Click on the  button and load the following dataset.  You can find 
it by either typing the name or filename in the “Search Text” textbox (you may 
use the * and ? wildcard characters), or by clicking on the Additional Vector DBC 
and finding the file in the list.
a. FAO National-Ad1 Boundaries (Ad1_Py.shp); from the Additional Vector 

Data DBC.

Change the theme names to the short versions by clicking the “View” menu item 
“Toggle AWRD data to Short Theme Names.”  You might have to click this menu item 
two times.

Find the Lukanga watershed in the Republic of Zambia:
❑ 1. Click on the alcomwwf.shp theme in the View Table of Contents to make it the 

active theme.
❑ 2. Click the  button to open the “Find Location by Theme” dialog.
❑ 3. Set the “Theme to Search” = “alcomwwf.shp”, and the “Field to Search” = “Ws_

name”.
❑ 4. Enter the search term “lukanga”.
❑ 5. Select “Lukanga [rec. 4792]” in the list and click “OK” to zoom into the Lukanga 

watershed.  Note:  This will not “select” the Lukanga watershed.  This function 
only zooms into the watershed extent.

Select the Lukanga watershed, plus all watersheds downstream:
❑ 1. Click the “Select Upstream and Downstream Watersheds” button .
❑ 2. Select the options “Include Selected Watershed” and “All Downstream 

Watersheds”
❑ 3. Click on Lukanga Watershed.
❑ 4. Zoom to the extent of the selected watersheds by clicking on the alcomwwf.shp 

theme in the View Table of Contents, then clicking the standard ArcView Zoom 
to Selected button .

Identify which countries intersect the selected watersheds:
❑ 1. Open the “Select by Theme” dialog by clicking the  button.
❑ 2. Select the features from ad1_py.shp that intersect the selected features of 

alcomwwf.shp.
❑ 3. Click the “Open Theme Table” button  on the Select By Theme dialog to 

view the attribute table for ad1_py.shp.
❑ 4. Use the standard ArcView Promote button  to bring the four selected 

countries to the top.
❑ 5. Given that the potential introduction of the invasive species were to occur in the 

Republic of Zambia, what countries might be impacted by this release because 
they are downstream?
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Part 3: Potential distribution of fish species based on preferred water 
temperatures for spawning and flow regimes

This exercise will illustrate the use of the AWRD classification tools to identify 
potential habitat for common carp based on water temperature and presence of 
perennial water.

Materials and methods 
Data utilized
This section uses the ALCOM-WWF watershed model to define the hydrological 
network, and the FAO National-Ad1 Boundaries to identify what countries are 
intersected by the downstream watersheds. The background image SRTM30_ShdBath.
jp2 provides a spatial reference (Table 2.31).

TABLE 2.31
Summary and purpose of data used

Name Description Filename File location Data utilization or 
purpose

ALCOM-WWF 
Watershed 
Model

A three level named 
watershed model of 
continental Africa

alcomwwf.shp [AWRD_Data]\ws_dbc\ Used to identify 
the region of 
the  contributing 
watershed.

alcomwwf_wat_
month.dbf

Monthly Temperature 
Statistics for 
Watersheds in 
alcomwwf.shp 
watershed model

alcomwwf_
wat_month.
dbf

[AWRD_Data]\dbf_data\ Used to identify 
monthly water 
temperatures in 
watersheds.  Loaded 
automatically by 
Watershed Statistics 
Module.

FAO-AquaStat 
1:5m African 
Rivers

Rivers from the 
FAO Atlas of Water 
Resources and 
Irrigation in Africa

wria_riv.shp [AWRD_Data]\riv_dbc\ Used to determine 
which watersheds 
actually have 
perennial water in 
them.

FAO National-
Ad1 Boundaries

National Political 
Boundary polygons of 
Africa

Ad1_Py.shp [AWRD_Data]\avec_dbc\
fao\

Background 
reference.

2.5d Enhanced 
NASA Blue 
Marble 30 as 
Mosaic

2.5d enhanced version 
of NASA Blue-Marble 
mosaic

BluMrbl_Shd.
jp2

[AWRD_Data]\aimg_dbc\ Background 
reference.  

Methods
Open ArcView and start the exercise by following the steps below.

Open a new view and the spatial data:
❑ 1. Set the watershed model to “alcomwwf.shp”:

a. Click the menu “AWRD Modules”, then the menu item “Change 
Watershed Model”.

b. Select “alcomwwf.shp” from the list of “Available Watershed Models”.
c. Select “Monthly Water Temperature Data” from the list of “Available 

Data”.
d. Click ‘OK’.  If “alcomwwf.shp” is not already in your view, you will now 

be asked if you would like to add it to the view.  Click “Yes”.
❑ 2. Click the Add Basemap button  and load the image “BluMrbl_Shd.jp2”.  

Note:  If this image looks extremely pixilated, try zooming out to the full extent 
of the view using the standard ArcView Zoom to Full Extent button , and 
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then back to your original extent using the standard ArcView Zoom to Previous 
Extent button .  This usually fixes the pixilation problem.

❑ 3. Click on the  button and load the following datasets.  You can find 
them by either typing the name or filename in the “Search Text” textbox (you may 
use the * and ? wildcard characters), or by clicking on the respective DBC and 
finding the file in the list.
a. FAO National-Ad1 Boundaries (Ad1_Py.shp); from the Additional Vector 

Data DBC.
b. FAO-AquaStat 1:5m African Rivers(wria_riv.shp); from the Rivers Data 

DBC.

Change the theme names to the short versions by clicking the “View” menu item 
“Toggle AWRD data to Short Theme Names.”  You might have to click this menu item 
two times.

Based on the range of spawning temperature ranges defined in Table 2.28 (“Required” = 
13º to 28º; “Optimum” = 17º to 23º) and an optimal spawning season from November 
to February, classify alcomwwf.shp into six categories based on the following criteria:

[A]. Score = 10 if mean monthly water temperature is in the required range in at 
least 1 month of the year.

[B]. Score = 50 if mean monthly water temperature is in the required range 12 
months of the year.

[C]. Score = 51 if mean monthly water temperature is in the required range 12 
months of the year, plus 1 month in the optimal range and season

[D]. Score = 52 if mean monthly water temperature is in the required range 12 
months of the year, plus 2 months in the optimal range and season

[E]. Score = 53 if mean monthly water temperature is in the required range 12 
months of the year, plus 3 months in the optimal range and season

[F]. Score = 54 if mean monthly water temperature is in the required range 12 
months of the year, plus 4 months in the optimal range and season

Steps:
❑ 1. Important:  Export your alcomwwf.shp shapefile to a new theme, so any edits 

made to it will not affect the original watershed model.
a. Click on the alcomwwf.shp theme in the View Table of Contents to make the 

theme active.
b. Click the ArcView Clear Selected Features button  to clear any selection.
c. Click the “Theme” menu, then “Convert to Shapefile”.
d. Choose a name (i.e. alcom_class.shp) and location.
e. When asked whether you want to add your new shapefile to your view, click 

“Yes”.
f. Delete your original alcomwwf.shp theme from your view.
g. Because you attached the monthly water temperature data to alcomwwf.shp 

before you exported it into a new shapefile, the new shapefile will contain all 
the monthly water temperature data.

❑ 2. Add a field to your attribute table to hold values indicating whether the watersheds 
have any monthly water temperatures within the required range of 13º to 28º.  For 
each watershed, set a value = 0  if no months are in the required range; a value of 1 
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if at least one month is in the required range, and a value of 2 if all twelve months 
are in the required range.
a. Open your alcom_class.shp attribute table by clicking the ArcView Open 

Theme Table button .
b. Set the table to editable by clicking the “Table” menu, then “Start Editing”.
c. Click the “Edit” menu, then “Add Field”.
d. Set the new field name to be “Required”.  Make it a Number, with Width = 

2 and Decimal Places = 0.
e. Select your new “Required” field and then calculate all records = 0 by 

clicking the “Calculate” button .  Simply type the value 0 into the box 
and click “OK”.

f. Select all the records that have at least one month in the required temperature 
range, by clicking the ArcView Query Builder button  and using the 
following query string:
((( [Wtemp_jan] >= 13) and ([Wtemp_jan] <= 28 )) OR
(( [Wtemp_feb] >= 13) and ([Wtemp_feb] <= 28 )) OR
(( [Wtemp_mar] >= 13) and ([Wtemp_mar] <= 28 )) OR
(( [Wtemp_apr] >= 13) and ([Wtemp_apr] <= 28 )) OR
(( [Wtemp_may] >= 13) and ([Wtemp_may] <= 28 )) OR
(( [Wtemp_jun] >= 13) and ([Wtemp_jun] <= 28 )) OR
(( [Wtemp_jul] >= 13) and ([Wtemp_jul] <= 28 )) OR
(( [Wtemp_aug] >= 13) and ([Wtemp_aug] <= 28 )) OR
(( [Wtemp_sep] >= 13) and ([Wtemp_sep] <= 28 )) OR
(( [Wtemp_oct] >= 13) and ([Wtemp_oct] <= 28 )) OR
(( [Wtemp_nov] >= 13) and ([Wtemp_nov] <= 28 )) OR
(( [Wtemp_dec] >= 13) and ([Wtemp_dec] <= 28 )))

g. Select your new “Required” field and then calculate all selected records = 1 
by clicking the “Calculate” button .  Simply type the value 1 into the box 
and click “OK”.

h. Select all the records that have at all twelve months in the required 
temperature range, by clicking the ArcView Query Builder button  and 
using the following query string:
((( [Wtemp_jan] >= 13) and ([Wtemp_jan] <= 28 )) AND
(( [Wtemp_feb] >= 13) and ([Wtemp_feb] <= 28 )) AND
(( [Wtemp_mar] >= 13) and ([Wtemp_mar] <= 28 )) AND
(( [Wtemp_apr] >= 13) and ([Wtemp_apr] <= 28 )) AND
(( [Wtemp_may] >= 13) and ([Wtemp_may] <= 28 )) AND
(( [Wtemp_jun] >= 13) and ([Wtemp_jun] <= 28 )) AND
(( [Wtemp_jul] >= 13) and ([Wtemp_jul] <= 28 )) AND
(( [Wtemp_aug] >= 13) and ([Wtemp_aug] <= 28 )) AND
(( [Wtemp_sep] >= 13) and ([Wtemp_sep] <= 28 )) AND
(( [Wtemp_oct] >= 13) and ([Wtemp_oct] <= 28 )) AND
(( [Wtemp_nov] >= 13) and ([Wtemp_nov] <= 28 )) AND
(( [Wtemp_dec] >= 13) and ([Wtemp_dec] <= 28 )))

i. Select your new “Required” field and then calculate all selected records = 2 
by clicking the “Calculate” button .  Simply type the value 2 into the box 
and click “OK”.
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❑ 3. Add four fields for values determining whether the watersheds had water 
temperatures within the optimal range of 17º to 23º for the months of November, 
December, January and February (the optimal breeding season).  For this example, 
we will further constrain these values so that the watersheds also have to have 
water temperatures within the required range for all twelve months through the 
year.  Values in these new fields will be set to 0 if they fail to meet the criteria and 
1 if they do meet the criteria.
a. Make a field for November Water Temperature.  Calculate a value of 0 

if the watershed November water temperature fails to meet the water 
temperature requirements, and a value of 1 if the temperature does meet the 
requirements.
i. Clear any selection by clicking the “Select None” button .
ii. Click the “Edit” menu, then “Add Field”.  Set the new field name = 

“November”, make it a Number, set the Width = 2 and the Decimal 
Places = 0.

iii. Select your new “November” field and then calculate all records = 0 by 
clicking the “Calculate” button .  Simply type the value 0 into the 
box and click “OK”.

iv. Select all the records that have at a November water temperature in the 
optimal temperature range, and all twelve months within the required 
range, by clicking the ArcView Query Builder button  and using 
the following query string:

(( [Wtemp_nov] >= 17) and ([Wtemp_nov] <= 23 ) and ([Required] = 2))
v. Select your new “November” field and then calculate all selected 

records = 1 by clicking the “Calculate” button .  Simply type the 
value 1 into the box and click “OK”.

b. Make a field for December Optimal Temperature.  Calculate a value of 
0 if the watershed December water temperature fails to meet the water 
temperature requirements, and a value of 1 if the temperature does meet the 
requirements.
i. Clear any selection by clicking the “Select None” button .
ii. Click the “Edit” menu, then “Add Field”.  Set the new field name = 

“December”, make it a Number, set the Width = 2 and the Decimal 
Places = 0.

iii. Select your new “December” field and then calculate all records = 0 by 
clicking the “Calculate” button .  Simply type the value 0 into the 
box and click “OK”.

iv. Select all the records that have at a December water temperature in the 
optimal temperature range, and all twelve months within the required 
range, by clicking the ArcView Query Builder button  and using 
the following query string:

(( [Wtemp_dec] >= 17) and ([Wtemp_dec] <= 23 ) and ([Required] = 2))
v. Select your new “December” field and then calculate all selected records 

= 1 by clicking the “Calculate” button .  Simply type the value 1 
into the box and click “OK”.
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c. Make a field for January Optimal Temperature.  Calculate a value of 
0 if the watershed January water temperature fails to meet the water 
temperature requirements, and a value of 1 if the temperature does meet the 
requirements.
i. Clear any selection by clicking the “Select None” button .
ii. Click the “Edit” menu, then “Add Field”.  Set the new field name = 

“January”, make it a Number, set the Width = 2 and the Decimal Places 
= 0.

iii. Select your new “January” field and then calculate all records = 0 by 
clicking the “Calculate” button .  Simply type the value 0 into the 
box and click “OK”.

iv. Select all the records that have at a January water temperature in the 
optimal temperature range, and all twelve months within the required 
range, by clicking the ArcView Query Builder button  and using 
the following query string:

(( [Wtemp_jan] >= 17) and ([Wtemp_jan] <= 23 ) and ([Required] = 2))
v. Select your new “January” field and then calculate all selected records = 

1 by clicking the “Calculate” button .  Simply type the value 1 into 
the box and click “OK”.

d. Make a field for February Optimal Temperature.  Calculate a value of 
0 if the watershed February water temperature fails to meet the water 
temperature requirements, and a value of 1 if the temperature does meet the 
requirements.
i. Clear any selection by clicking the “Select None” button .
ii. Click the “Edit” menu, then “Add Field”.  Set the new field name = 

“February”, make it a Number, set the Width = 2 and the Decimal 
Places = 0.

iii. Select your new “February” field and then calculate all records = 0 by 
clicking the “Calculate” button .  Simply type the value 0 into the 
box and click “OK”.

iv. Select all the records that have at a February water temperature in the 
optimal temperature range, and all twelve months within the required 
range, by clicking the ArcView Query Builder button  and using 
the following query string:

(( [Wtemp_feb] >= 17) and ([Wtemp_feb] <= 23 ) and ([Required] = 2))
v. Select your new “February” field and then calculate all selected records 

= 1 by clicking the “Calculate” button .  Simply type the value 1 
into the box and click “OK”.

e. Save your edits by clicking the “Table” menu, then “Stop Editing”.
f. Close the attribute table for alcom_class.shp and return to your View.

❑ 4. Click the “Classify Theme by Multiple Criteria” button .
❑ 5. Select the Theme = “alcom_class.shp” and the ID Field = “WS_id”.
❑ 6. The “Rank and Display Features by Specific Criteria” dialog will open.  If the 

dialog says “Simple Version” on the title bar, switch it to the “Advanced Version” 
by clicking the “Advanced” button at the bottom of the dialog.
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❑ 7. Check the option to “Show All Fields”.
❑ 8. Add a classification criteria for watersheds with at least 1 month in the required 

temperature range:
a. Select “Required” in the Field Name list.
b. Set Criteria 1:  Field Value >= 1
c. Set option to Skip Criteria 2 in drop-down list.
d. Set the Weight = 10
e. Set “Critical” = True
f. Set “Include or Exclude” = “Include”
g. Click “Add to List”.

❑ 9. Add a classification criteria for watersheds with all twelve months in the required 
temperature range:
a. Select “Required” in the Field Name list.
b. Set Criteria 1:  Field Value = 2
c. Set option to Skip Criteria 2 in drop-down list.
d. Set the Weight = 40
e. Set “Critical” = False
f. Set “Include or Exclude” = “Include”
g. Click “Add to List”.

❑ 10. Add a classification criteria for watersheds within the optimal temperature 
range during November:
a. Select “November” in the Field Name list.
b. Set Criteria 1:  Field Value = 1
c. Set option to Skip Criteria 2 in drop-down list.
d. Set the Weight = 1
e. Set “Critical” = False
f. Set “Include or Exclude” = “Include”
g. Click “Add to List”.

❑ 11. Add a classification criteria for watersheds within the optimal temperature 
range during December:
a. Select “December” in the Field Name list.
b. Set Criteria 1:  Field Value = 1
c. Set option to Skip Criteria 2 in drop-down list
d. Set the Weight = 1
e. Set “Critical” = False
f. Set “Include or Exclude” = “Include”
g. Click “Add to List”.

❑ 12. Add a classification criteria for watersheds within the optimal temperature 
range during January:
a. Select “January” in the Field Name list.
b. Set Criteria 1:  Field Value = 1
c. Set option to Skip Criteria 2 in drop-down list.
d. Set the Weight = 1
e. Set “Optimal” = False
f. Set “Include or Exclude” = “Include”
g. Click “Add to List”.

❑ 13. Add a classification criteria for watersheds within the optimal temperature 
range during February:
a. Select “February” in the Field Name list.
b. Set Criteria 1:  Field Value = 1
c. Set option to Skip Criteria 2 in drop-down list.
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d. Set the Weight = 1
e. Set “Critical” = False
f. Set “Include or Exclude” = “Include”
g. Click “Add to List”.

❑ 14. Save your classification criteria.  This will save time when you do the next part 
of the exercise.

❑ 15. Click “OK” to classify alcom_class.shp according to your classification 
criteria.

Now you have classified the continent of Africa according to required and optimal 
carp spawning temperatures, and therefore you have identified regions that range 
from poor-to-excellent potential for maintaining carp populations.  However, many 
of these watersheds are in dry climates without perennial water sources, and which 
are therefore unlikely to support carp populations.  The next step of this exercise is to 
restrict the analysis to only those watersheds that actually have water in them.
❑ 1. Open your alcom_class.shp attribute table by clicking the ArcView Open Theme 

Table button .
❑ 2. Set the table to Editable by clicking the “Table” menu, then “Start Editing”.
❑ 3. Click the “Edit” menu, then “Add Field”.
❑ 4. Set the new field name to be “Perennial”.  Make it a Number, with Width = 2 and 

Decimal Places = 0.
❑ 5. Select your new “Perennial” field and then calculate all records = 0 by clicking the 

“Calculate” button .  Simply type the value 0 into the box and click “OK”.
❑ 6. Save your edits by clicking the “Table” menu, then “Stop Editing”. 
❑ 7. Return to your View.
❑ 8. Use the AWRD Query Builder tool  to select the perennial rivers from 

wria_riv.shp.  Use the following query string:
( [Regime] = 1 )

❑ 9. Use the AWRD Select by Theme tool  to select the watersheds from alcom_
class.shp which intersect these selected perennial rivers.  

❑ 10. Open the alcom_class.shp attribute table using the ArcView Open Theme Table 
button .

❑ 11. Set the table to Editable by clicking the “Table” menu, then “Start Editing”.
❑ 12. Select your new Perennial field and calculate all selected records = 1 by clicking 

the “Calculate” button .  Simply type the value 1 into the box and click 
“OK”.

❑ 13. Save your edits by clicking the “Table” menu, then “Stop Editing”.
❑ 14. Return to your View.
❑ 15. Click the “Classify Theme by Multiple Criteria” button .
❑ 16. Select the Theme = “alcom_class.shp” and the ID Field = “WS_id”.
❑ 17. When your “Rank and Display Features by Specific Criteria” dialog opens, click 

the “Load” button and load the criteria set you saved in the previous part of this 
exercise.  If you did not save your criteria from the previous exercise, they you 
will need to recreate them following the steps above.

❑ 18. Add a new criteria to filter out the watersheds that do not have perennial 
water: 

a. Select “Perennial” in the Field Name list.
b. Set Criteria 1:  Field Value = 1
c. Set option to Skip Criteria 2.
d. Set the Weight = 0
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e. Set “Critical” = True
f. Set “Include or Exclude” = “Include”
g. Click “Add to List”.

❑ 19. Save your revised classification criteria if you wish.  
❑ 20. Click “OK” to classify alcom_class.shp according to your classification 

criteria.

Exercise Summary
This exercise has demonstrated how to generate observed and potential distributions 
of aquatic species, using both downloaded data from FishBase as well as data from 
the AWRD archive.  Tools and data from the watershed module were used to identify 
watersheds that were downstream from a potential introduction point, providing 
an example of how to identify areas along the hydrological network that might be 
impacted by management actions.  Finally, this exercise demonstrated the use of the 
classification tools to rank watersheds in accordance with their suitability for carp 
spawning.
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EXERCISE 6. Production of simple map graphical outputs and base mapping

The purpose of this exercise is demonstrate how the AWRD base mapping tools can be 
used to easily generate high-quality maps, and export those maps to images files that 
can be printed or incorporated into documents or presentations.

Estimated time for completion: 2 hours

AWRD Tools  utilized

This exercise makes use of tools available in the AWRD’s Data and Metadata Module, 
Watersheds Module, Additional Tools and Customization Module, Image Export and 
Base Mapping Tool, and an ESRI Add-On Extension (Table 2.32). 

TABLE  2.32
Summary of AWRD buttons and menu items

Button Menu option Action executed

Data and Metadata Module
View: “Load 
AWRD Data…”

Load AWRD Data: this button opens the main AWRD Data Inventory dialog, 
allowing users to search for and load data layers by name or by DBC. 

N/A
Theme: “Toggle 
AWRD Data 
Names”

Toggle AWRD to Short/Long Theme Names:  This tool changes the name of 
your dataset in your view, switching between long descriptive names and 
abbreviated names.

N/A
“Adjust Polygon 
Border and 
Pattern”

This tool simplifies the process of making attractive legends for polygon 
themes.  It includes functions to modify or eliminate the polygon borders, 
and/or to set transparency patterns simultaneously for all classifications in a 
legend.

Watersheds Module

“Change 
Watershed 
Model…”

Change Model: this function is used to change or switch analyses between 
watershed  models. This extension comes with several options (see 
discussion of Watershed Models) and provides users the ability to customize 
the AWRD by adding their own data.

N/A

Identify Upstream and Downstream Watersheds: this tool opens the 
“Watershed Visualization Tools” dialog to produce a clear visual map of all 
the watersheds that are hydrologically related to any particular watershed , 
i.e. watersheds that are upstream,  downstream,  or within the same 
megabasin,  plus tools to zoom  to the extents of any of these components, 
to flash the borders of any region, to move upstream  or downstream from 
the base watershed, and to save the flow regime.

N/A

Select Upstream and Downstream Watersheds: clicking this tool opens the 
Watershed Selection Criteria tool dialog, allowing users to select watersheds 
based on their hydrological relationship to a particular watershed  selected 
by the user.

Additional Tools and Customization Module

“Find Location by 
Theme...”

Find Location by Theme: this tool allows you to find and zoom  to particular 
features by selecting that feature from a list.

AWRD Tools 
“Query Builder…”

Model Query Builder: this tool gives the user the ability to apply complex 
queries to the data to either select features or to apply a theme  definition.  
This function is described in detail in Section 1.7.

“Add a Basemap 
Image to View...”

Add a Basemap Image to View: this tool allows you to quickly and easily 
add a background  image  to a view. These images can be very useful for 
both aesthetic and analytical purposes. 

Image Export and Base Mapping Tool

N/A
View:  Create LO/
ViewFrame-Page

Create a Layout containing a ViewFrame fitting the exact dimension of the 
page size 

N/A
Layout: “Output a 
Single PixMap”

Output a geo-referenced image  at user specified DPI

N/A
“Create Fitted 
Map”

Based on View selection  set, create a A4/Letter Layout with a fitted/scaled 
ViewFrame  

N/A
“Load Theme 
Database”

Load precompiled theme  sets into current/new View

ESRI Add-On Extensions
ESRI Legend Tool 
Extension

Legend Tool Extension:  This ESRI tool adds functions to generate complex 
legends.  The extension is loaded automatically by the AWRD extension.
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Part 1:  Creation of mean annual precipitation map of Africa

This exercise will illustrate how to generate a continental-scale map of mean annual 
precipitation across Africa, based on precipitation statistics generated for the Hydro-
1K watershed model.

Materials and methods 
Data utilized
This exercise uses the Hydro-1K watershed model, in conjunction with precipitation 
statistics, to illustrate the precipitation patterns across Africa.  The image “2.5d 
Enhanced ETopo2 Colored Terrain/Bathymetry” is uses for the background, and the 
FAO National Boundary polygons are used as a spatial reference (Table 2.33).

TABLE 2.33
Summary and purpose of data used

Name Description Filename File location Data utilization or 
purpose

HYDRO-1 
Kilometer 
Watershed 
Model

A six level watershed 
model and derivative 
flow routes

h1k_lev6.shp [AWRD_Data]\ws_dbc\ Delineation of the 
landscape, used in 
conjunction with 
precipitation statistics.

h1k_lev6_prec_
ann.dbf

Precipitation Statistics 
for polygons in h1k_
lev6.shp watershed 
model

h1k_lev6_
prec_ann.dbf

[AWRD_Data]\dbf_data\ Used to identify mean 
annual precipitation 
in watershed 
polygons.  Loaded 
automatically by 
Watershed Statistics 
Module.

2.5d Enhanced 
ETopo2 
Colored Terrain/
Bathymetry

RGB color image 
of nominal 3.7 Km 
bathymetry and 
terrestrial elevation 
values

ETopo2_2-
5d.jp2

[AWRD_Data]\aimg_dbc\ Background image

FAO National-
Ad1 Boundaries

National 1st Order-
Ad1 African political 
boundaries

Ad1_Py.shp [AWRD_Data]\avec_dbc\ National boundary 
reference.

Methods
Open ArcView and start the exercise by following the steps below.

Open a new view and set the name to “Africa Precipitation”, by clicking the “View” 
menu and then “Properties”.

Add data to your view:
❑ 1. Set the watershed model to “h1k_lev6.shp” and attach the annual precipitation 

data:
a. Click the menu “AWRD Modules”, then the menu item “Change 

Watershed Model”.
b. Select “h1k_lev6.shp” from the list of “Available Watershed Models”.
c. Select “Annual Precipitation Data” from the list of “Available Data”.
d. Click ‘OK’.  If “h1k_lev6.shp” is not already in your view, you will now 

be asked if you would like to add it to the view.  Click “Yes”.
❑ 2. Click the Add Basemap button  and load the image “ETopo2_2-5d.jp2”.  

Note:  If this image looks extremely pixilated, try zooming out to the full extent 
of the view using the standard ArcView Zoom to Full Extent button , and 
then back to your original extent using the standard ArcView Zoom to Previous 
Extent button .  This usually fixes the pixilation problem.
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❑ 3. Click on the  button and load the following dataset.  You can find 
it by either typing the name or filename in the “Search Text” textbox (you may 
use the * and ? wildcard characters), or by clicking on the Additional Vector DBC 
and finding the file in the list.
a. FAO National-Ad1 Boundaries (Ad1_Py.shp); from the Additional Vector 

Data DBC.

Change the theme names to the short versions by clicking the “View” menu item 
“Toggle AWRD data to Short Theme Names.”  You might have to click this menu item 
two times.

Make sure your themes are sorted correctly in the View Table of Contents.  They 
should be in the following order:
❑ 1. Ad1_Py.shp
❑ 2. h1k_lev6.shp
❑ 3. Etopo2_2-5d.jp2

Zoom in to the extent of your Ad1_Py.shp theme by clicking on the Ad1_py.shp theme 
in the View Table of Contents so that it is the active theme, then clicking the standard 
ArcView Zoom to Active Theme(s) button .

Set the legend properties of Ad1_Py.shp so that only the borders are visible:
❑ 1. Click on Ad1_py.shp in the View Table of Contents so that it is the active 

theme.
❑ 2. Click the “Theme” menu, then “Adjust Polygon Border and Pattern…”.
❑ 3. Choose the option “Use Outline”.
❑ 4. Choose the option “Constant Outline Color”
❑ 5. Click the “Set Color” button and choose a medium gray color.
❑ 6. Set the “Outline Width” = 1
❑ 7. Choose the hollow pattern (the pattern symbol in the top left corner of the list of 

available patterns).
❑ 8. Click “OK”.

Set the legend properties of h1k_lev6.shp so that it is shaded according to the amount 
of precipitation in each watershed polygon:
❑ 1. Double-click on h1k_lev6.shp in the View Table of Contents to open the Legend 

Editor.
❑ 2. Set “Legend Type” = “Graduated Color”
❑ 3. Set “Classification Field” = “Aprec_mean”    (for Mean Annual Precipitation)
❑ 4. Click the “Classify” button and enter “Number of classes” = 10.
❑ 5. Set the “Color Ramp” = “Blue Monochromatic”.
❑ 6. Close the Legend Editor.
❑ 7. Click the “Theme” menu, then “Adjust Polygon Border and Pattern…”.
❑ 8. Choose the option “Do Not Use Outline”.
❑ 9. Click “OK”.
❑ 10. Click the “Theme” menu, then “Properties”
❑ 11. Set the theme name = “Precipitation (mm/yr)”
❑ 12. Click “OK”.
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Convert the view to a 15 cm x 15 cm layout:
❑ 1. Click the “ImageExport” menu, then “Create LO/ViewFrame-Page”
❑ 2. Set the Page Setup “Units” = “Centimeters”
❑ 3. Set the “Width” = 15
❑ 4. Set the “Height” = 15
❑ 5. The layout will appear, and the only thing you will see on the layout will be the 

view frame containing the view.  
❑ 6. Double-click on the view frame to open the View Frame Properties dialog.
❑ 7. Set the “Scale” – “User Specified Scale”
❑ 8. Set the scale value = 70000000 (70 million)
❑ 9. Click “OK”.

Note that the layout is linked to the view.  If you move or add anything to the view, 
it will also appear in the layout.  You may wish to try panning the view using the 
ArcView Pan tool  and observing the effects on the layout.  You will often need to 
pan the view a bit to get the image in the layout positioned correctly, especially after 
adding features like legends to the layout.

Add a legend to your layout, explaining the colors that correspond with each 
precipitation level.

❑ 1. Click the Custom Legend Tool  in your Layout tool bar.
❑ 2. Click in your layout somewhere, to open the “Custom Legend” dialog.
❑ 3. Read the introductory text, then click “Next” to go to Step 1 of the Custom 

Legend Tool.
❑ 4. While in Step 1 of the Custom Legend tool:

a. Set the View = “Africa Precipitation”
b. Select the theme “Precipitation (mm/yr)” to show in your custom legend.
c. For the “number of label and symbol columns”, select “One per theme”.
d. Click “Next” to go to Step 2.

❑ 5. While in Step 2 of the Custom Legend Tool:
a. Set the “Optional Title” = “Precipitation (mm/yr)”
b. Set the “Title Font” = “Arial”
c. Set the “Title Size (pts)” = 18
d. Set the “Title Style” = “Normal”
e. On the “Title Positioning Options, choose the option that is centered 

directly above the image.
f. Click “Next” to go to Step 3.

❑ 6. While in Step 3 of the Custom Legend Tool:
a. Select the top border style (a single line).
b. Set the “Border Width” = 1.5
c. Set the “Border Color” = “Black”
d. Set the “Background Color” = “Light Gray”
e. Click “Next” to go to Step 4.

❑ 7. While in Step 4 of the Custom Legend Tool:
a. Select the option to show area symbols as Rectangles.
b. The option for line symbols does not apply here, as there are no polyline 

themes being symbolized in this legend.
c. Click “Next” to go to Step 5.

❑ 8. While in Step 5 of the Custom Legend Tool:
a. Leave the default values as they are.
b. Click the “Preview” button to see how the legend looks.
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c. It will probably be to large, but that can be fixed later.  Decide if you like the 
text and colors of the legend.  If it is acceptable, click “Finish” to close the 
Custom Legend Tool.

❑ 9. The legend will probably need to be moved and resized:
a. Use the ArcView Pointer tool  to select your new legend.
b. Drag the legend down to the lower left corner of the layout.
c. Because the legend is selected, it will have small squares on the sides and at 

the corners of the legend.  These squares are called “handles”.  If you wish 
to resize the legend, click on one of the corner handles and drag it to change 
the dimensions.  

d. Position and size the legend so that it looks good to you.
e. If you wish, you can decompose the legend into separate elements by 

clicking the ArcView Ungroup button .  You may need to click it several 
times before you get all the subgroups split up.  Then you can select each 
individual element and modify it using the Symbol Window.  For example, 
you could set the some of the text to be a different font or a larger font size.  
It would be a good idea to regroup the legend elements when you finish 
(select them all, then click the ArcView Group button ), so that the 
entire legend can easily be resized or repositioned.

Export the image to a *.bmp file:
❑ 1. Click the “ImageExport” menu, then “Output a Single Pixmap”.
❑ 2. For Output Image Type, select “BMP”.
❑ 3. You may be asked if you wish to convert the BMP to another image type.  This 

option is only available if you have installed IrfanView.  For this example, we will 
choose “No” if we are offered this option.

❑ 4. Select a name and location to create your image file.
❑ 5. Select a resolution = 200 for the image file.  Note:  Often the default resolution 

value will produce a very high-resolution image, and you can usually reduce the 
default value to keep down the image size.

❑ 6. The layout will change size while the function is working.  Upon completion, 
you will see a report of some statistical information on the pixel size.  Note:  If 
possible, this function will also create a “World File” that allows the image to be 
used in a GIS system.  The report also gives details on the data included in the 
world file.

❑ 7. Click “OK” to close the report, and your layout will return to the proper size.

Now the image file can be treated like any other image file, added to documents or 
presentations or emailed.  It can also be further edited in any image processing software 
you may use.  If it has a world file, it can even be imported into a GIS and treated like 
any other image-based spatial data layer.

Try opening a program that accepts images, such as Microsoft Word or Powerpoint (or 
even ArcView), and importing your new image.
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Part 2:  Map of population density in Lake Volta
This exercise will demonstrate a method to show only the portion of a dataset, using 
population densities in the Lake Volta drainage basin as an example.  The dataset covers 
a much larger region than the Lake Volta area, but we will hide that portion so that we 
can focus the viewer’s attention on the area of interest. 

Materials and methods 
Data utilized
This exercise uses the ALCOM-WWF watershed model, in conjunction with 
population density statistics, to illustrate the population densities in the Volta River 
megabasin.  The image “Color Shade of SRTM30as w/ETopo2 Bathymetry” is uses for 
the background, and the FAO National Boundary polygons, VMap0 Capital Cities, 
and DCW-VMap0 Surface Waterbodies are used as spatial references (Table 2.34).

TABLE 2.34
Summary and purpose of data used

Name Description Filename File location Data utilization or 
purpose

ALCOM-WWF 
Watershed 
Model

A three level named 
watershed model of 
continental Africa

alcomwwf.shp [AWRD_Data]\ws_dbc\ Used to identify 
the region of 
the  contributing 
watershed.

alcomwwf_
pop2k.dbf

Population Density 
Statistics for polygons 
in alcomwwf.shp 
watershed model

alcomwwf_
pop2k.dbf

[AWRD_Data]\dbf_data\ Used to identify 
mean population 
densities in 
watershed polygons.  
Loaded automatically 
by Watershed 
Statistics Module.

Harmonized 
DCW-VMap0 
Surface Water 
Bodies

Seamless and 
topologically robust 
derivative of source 
DCW and VMap0 
perennial/non-
perennial SWBs from 
VMAP0-IW, DCW-
DNNET and DCW-
LCPOLY sources

dniw_hyd.shp [AWRD_Data]\swb_dbc\ Used to highlight 
the major surface 
waterbodies in the 
view.

VMap0 Capital 
Cities

8 topical data layers 
compiled from sixty+ 
source layers

Captl_Pt.shp [AWRD_Data]\avec_dbc\
vmap0\

Spatial reference.

FAO National-
Ad1 Boundaries

National 1st Order-
Ad1 African political 
boundaries

Ad1_Py.shp [AWRD_Data]\avec_dbc\ National boundary 
reference.

Color Shade 
of SRTM30as 
w/ETopo2 
Bathymetry

2.5d enhanced RGB 
image of SRTM-30 
terrestrial elevation and 
ETopo2 bathymetric 
data

SRTM30_
ShdBath.jp2

[AWRD_Data]\aimg_dbc\ Background Image.  

Methods
Open ArcView and start the exercise by following the steps below.

Open a new view and name it “Lake Volta”.

Add the following data:
❑ 1. Set the watershed model to “alcomwwf.shp” and attach the annual precipitation 

data:
a. Click the menu “AWRD Modules”, then the menu item “Change 

Watershed Model”.
b. Select “alcomwwf.shp” from the list of “Available Watershed Models”.
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c. Select “Population Density 2000” from the list of “Available Data”.
d. Click ‘OK’.  If “alcomwwf.shp” is not already in your view, you will now 

be asked if you would like to add it to the view.  Click “Yes”.

❑ 2. Click the Add Basemap button  and load the image “Srtm30_shdbath.jp2”.  
Note:  If this image looks extremely pixilated, try zooming out to the full extent 
of the view using the standard ArcView Zoom to Full Extent button , and 
then back to your original extent using the standard ArcView Zoom to Previous 
Extent button .  This usually fixes the pixilation problem.

❑ 3. Click on the  button and load the following datasets.  You can find 
them by either typing the name or filename in the “Search Text” textbox (you may 
use the * and ? wildcard characters), or by clicking on the Additional Vector DBC 
and finding the files in the list.
a. FAO National-Ad1 Boundaries (Ad1_Py.shp); from the Additional Vector 

Data DBC.
b. VMap0 Capital Cities (Captl_Pt.shp); from the Additional Vector Data 

DBC.
c. Harmonized DCW-VMap0 Surface Water Bodies(dniw_hyd.shp); from the 

Additional Vector Data DBC.

Change the theme names to the short versions by clicking the “View” menu item 
“Toggle AWRD data to Short Theme Names.”  You might have to click this menu item 
two times.

Make sure your themes are sorted correctly in the View Table of Contents.  They 
should be in the following order:
❑ 1. Captl_Pt.shp
❑ 2. dniw_hyd.shp
❑ 3. Ad1_Py.shp
❑ 4. alcomwwf.shp
❑ 5. SRTM30_ShdBath.jp2

Set the legend properties of Ad1_Py.shp so that only the borders are visible:
❑ 1. Click on Ad1_py.shp in the View Table of Contents so that it is the active 

theme.
❑ 2. Click the “Theme” menu, then “Adjust Polygon Border and Pattern…”.
❑ 3. Choose the option “Use Outline”.
❑ 4. Choose the option “Constant Outline Color”
❑ 5. Click the “Set Color” button and choose a medium gray color.
❑ 6. Set the “Outline Width” = 1
❑ 7. Choose the hollow pattern (the pattern symbol in the top left corner of the list of 

available patterns).
❑ 8. Click “OK”.

Zoom in to the area of interest, defined as the extent of the Black Volta, White Volta, 
Oti and Volta River basins, and set only these watersheds to be visible:
❑ 1. Select alcomwwf.shp from the View Table of Contents to make it the active 

theme.
❑ 2. Use the  button to open the AWRD Query Builder.
❑ 3. At the bottom of the dialog, make sure that the “Found Features” option is set to 

“Select”.
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❑ 4. Select the watersheds in the Black Volta, White Volta, Oti and Volta River Basins 
using the following query string:

 ( [Basin_name] = “Black Volta” )  OR ( [Basin_name] = “White Volta” ) OR ( 
[Basin_name] = “Oti” ) OR ( [Basin_name] = “Volta River” )

❑ 5. Leave the Query Builder dialog open, and click the ArcView “Zoom to Selected 
Features” button  to zoom into the selected area.

❑ 6. We are only interested in these selected watersheds, and we set all other watersheds 
to be invisible.  We can do this by setting the theme definition, using the AWRD 
Query Builder dialog:
a. Near the bottom of the Query Builder Dialog, set the “Found Features” 

option to “Set Theme Definition”.
b. Set the following definition string (which is the same string used above):

( [Basin_name] = “Black Volta” )  OR ( [Basin_name] = “White Volta” ) OR ( 
[Basin_name] = “Oti” ) OR ( [Basin_name] = “Volta River” )

c. Click “New” to set the definition.
d. Close the Query Builder dialog.

❑ 7. Clear the selection on alcomwwf.shp by clicking the ArcView Clear Selection 
button .

Set the legend properties of alcomwwf.shp so that it is shaded according to the 
population density in each watershed polygon:
❑ 1. Double-click on alcomwwf.shp in the View Table of Contents to open the Legend 

Editor.
❑ 2. Set “Legend Type” = “Graduated Color”
❑ 3. Set “Classification Field” = “P2k_mean”    (for 2000 Mean Population Density)
❑ 4. Click the “Classify” button and enter “Number of classes” = 10.
❑ 5. Set the “Color Ramp” = “Red Monochromatic”.
❑ 6. Ramp the colors using the Ramp button .
❑ 7. Close the Legend Editor.
❑ 8. Click the “Theme” menu, then “Adjust Polygon Border and Pattern…”.
❑ 9. Choose the option “Do Not Use Outline”.
❑ 10. Click “OK”.
❑ 11. Click the “Theme” menu, then “Properties”
❑ 12. Set the theme name = “Volta Population”
❑ 13. Click “OK”.

Add labels to your view, providing names for countries and capitals:
❑ 1. Open your ArcView symbol window by either clicking [CONTROL]-P, or 

clicking the “Window” menu and then “Show Symbol Window…”.
❑ 2. Add the Country Name labels:

a. In the Symbol Window, set the default text to be Times New Roman, with 
“Size” = 24 and “Style” = “Bold”.

b. Click the theme Ad1_Py.shp in your View Table of Contents to make it the 
active theme.

c. Open the Auto-Label dialog by either clicking [CONTROL]-L, or by 
clicking the “Theme” menu and then “Auto-Label…”.

d. Set the Label Field = “Country_na”
e. Choose the option “Find Best Label Placement
f. Choose the option “Remove Duplicates”
g. Choose the option “Scale Labels”
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h. Click “OK”. 
i. If you wish to add additional country name labels manually, use the ArcView 

Label tool  to click on the view wherever you wish to place a new label.
❑ 3. Add the Capital City Name labels:

a. In the Symbol Window, set the default text to be Arial, with “Size” = 18 and 
“Style” = “Italic”.

b. Click the theme Captl_Pt.shp in your View Table of Contents to make it the 
active theme.

c. Open the Auto-Label dialog by either clicking [CONTROL]-L, or by 
clicking the “Theme” menu and then “Auto-Label…”.

d. Set the Label Field = “Name_propr”
e. Choose the option “Find Best Label Placement
f. Choose the option “Remove Duplicates”
g. Choose the option “Scale Labels”
h. Click “OK”. 

❑ 4. Close the Symbol Window.
❑ 5. If necessary, you can move any of these labels by selecting it with the  tool, 

and dragging it to a new location.

Convert the view to a 16 cm x 20 cm layout:
❑ 1. Click the “ImageExport” menu, then “Create LO/ViewFrame-Page”
❑ 2. Set the Page Setup “Units” = “Centimeters”
❑ 3. Set the “Width” = 16
❑ 4. Set the “Height” = 20
❑ 5. The layout will appear, and the only thing you will see on the layout will be the 

view frame containing the view.  
❑ 6. Double-click on the view frame to open the View Frame Properties dialog.
❑ 7. Set the “Scale” – “User Specified Scale”
❑ 8. Set the scale value = 6500000 (6.5 million)
❑ 9. Click “OK”.

Note that the layout view frame is linked to the view.  If you move or add anything 
to the view, it will also appear in the layout view frame.  You may wish to try panning 
the view using the ArcView Pan tool  and observing the effects on the layout.  You 
will often need to pan the view a bit to get the image in the layout positioned correctly, 
especially after adding features like legends to the layout.  If you wish, you can unlink 
the layout view frame by double clicking on the view frame to open the “View Frame 
Properties” dialog, and then unchecking the “Live Link” checkbox.

Add a legend to your layout, explaining the colors that correspond with each 
population density level.
❑ 1. Click the Custom Legend Tool  in your Layout tool bar.
❑ 2. Click in your layout somewhere, to open the “Custom Legend” dialog.
❑ 3. Read the introductory text, then click “Next” to go to Step 1 of the Custom 

Legend Tool.
❑ 4. While in Step 1 of the Custom Legend tool:

a. Set the View = “Lake Volta”
b. Select the theme “Volta Population” to show in your custom legend.
c. For the “number of label and symbol columns”, select “One per theme”.
d. Click “Next” to go to Step 2.
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❑ 5. While in Step 2 of the Custom Legend Tool:
a. Set the “Optional Title” = “Population Density (pp/km2)”
b. Set the “Title Font” = “Arial”
c. Set the “Title Size (pts)” = 18
d. Set the “Title Style” = “Normal”
e. On the “Title Positioning Options, choose the option that is centered 

directly above the image.
f. Click “Next” to go to Step 3.

❑ 6. While in Step 3 of the Custom Legend Tool:
a. Select the top border style (a single line).
b. Set the “Border Width” = 1.5
c. Set the “Border Color” = “Black”
d. Set the “Background Color” = “White”
e. Click “Next” to go to Step 4.

❑ 7. While in Step 4 of the Custom Legend Tool:
a. Select the option to show area symbols as Rectangles.
b. The option for line symbols does not apply here, as there are no polyline 

themes being symbolized in this legend.
c. Click “Next” to go to Step 5.

❑ 8. While in Step 5 of the Custom Legend Tool:
a. Leave the default values as they are.
b. Click the “Preview” button to see how the legend looks.
c. It will probably be to large, but that can be fixed later.  Decide if you like the 

text and colors of the legend.  If it is acceptable, click “Finish” to close the 
Custom Legend Tool.

❑ 9. The legend will probably need to be moved and resized:
a. Use the ArcView Pointer tool  to select your new legend.
b. Drag the legend down to the lower left corner of the layout.
c. If you wish to resize the legend, click on one of the corner handles and drag 

it to change the dimensions.  
d. Position and size the legend so that it looks good to you.
e. If you wish, you can decompose the legend into separate elements by 

clicking the ArcView Ungroup button .  You may need to click it several 
times before you get all the subgroups split up.  Then you can select each 
individual element and modify it using the Symbol Window.  For example, 
you could set the some of the text to be a different font or a larger font size.  
It would be a good idea to regroup the legend elements when you finish 
(select them all, then click the ArcView Group button ), so that the 
entire legend can easily be resized or repositioned.

Export the layout to a *.jpg image:
❑ 1. Click the “ImageExport” menu, then “Output a Single Pixmap”.
❑ 2. For Output Image Type, select “JPG”.
❑ 3. Select a name and location to create your image file.
❑ 4. Select a resolution = 200 for the image file.  Note:  Often the default resolution 

value will produce a very high-resolution image, and you can usually reduce the 
default value to keep down the image size.

❑ 5. The layout will change size while the function is working.  Upon completion, 
you will see a report of some statistical information on the pixel size.  Note:  If 
possible, this function will also create a “World File” that allows the image to be 
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used in a GIS system.  The report also gives details on the data included in the 
world file.

❑ 6. Click “OK” to close the report, and your layout will return to the proper size.

Now the image file can be treated like any other image file, added to documents or 
presentations or emailed.  It can also be further edited in any image processing software 
you may use.  If it has a world file, it can even be imported into a GIS and treated like 
any other image-based spatial data layer.

Try opening a program that accepts images, such as Microsoft Word or Powerpoint (or 
even ArcView), and importing your new image.

Part 3:  Map of flow regime associated with the Lake Tanganyika basin
This exercise is similar to the previous two exercises, except that the final map legend 
is slightly more complicated.

Materials and methods 
Data utilized
This exercise uses the ALCOM-WWF watershed model to illustrate the flow regime 
associated with Lake Tanganyika. The image “Color Shade of SRTM30as w/ETopo2 
Bathymetry” is uses for the background, and the FAO National Boundary polygons, 
FAO-AquaStat Rivers and FAO-AquaStat Surface Waterbodies are used as spatial 
references (Table 2.35).

TABLE 2.35
Summary and purpose of data used

Name Description Filename File location Data utilization or 
purpose

ALCOM-WWF 
Watershed Model

A three level named 
watershed model of 
continental Africa

alcomwwf.shp [AWRD_Data]\ws_dbc\ Used to identify 
the region of 
the  contributing 
watershed.

FAO-AquaStat 
1:1m Major African 
SWBs

Modified Major 
African SWBs 
originally from DCW

wria_swb.shp [AWRD_Data]\swb_dbc\ Used to highlight 
the major surface 
waterbodies in the 
view.

FAO-AquaStat 
1:5m African Rivers

Rivers, surface 
waterbodies and 
2 level watershed 
model

wria_riv.shp [AWRD_Data]\riv_dbc\ Spatial reference.

FAO National-Ad1 
Boundaries

National 1st Order-
Ad1 African political 
boundaries

Ad1_Py.shp [AWRD_Data]\avec_dbc\ National boundary 
reference.

Color Shade of 
SRTM30as w/
ETopo2 Bathymetry

2.5d enhanced RGB 
image of SRTM-30 
terrestrial elevation 
and ETopo2 
bathymetric data

SRTM30_
ShdBath.jp2

[AWRD_Data]\aimg_dbc\ Background Image.  

Methods
Open ArcView and start the exercise by following the steps below.

Open a new view and name it “Lake Tanganyika”.

Add the following data:
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❑ 1. Set the watershed model to “alcomwwf.shp” and attach the annual precipitation 
data:
a. Click the menu “AWRD Modules”, then the menu item “Change 

Watershed Model”.
b. Select “alcomwwf.shp” from the list of “Available Watershed Models”.
c. This exercise does not require any additional data.  You may select any 

datasets you wish or none at all.
d. Click ‘OK’.  If “alcomwwf.shp” is not already in your view, you will now 

be asked if you would like to add it to the view.  Click “Yes”.

❑ 2. Click the Add Basemap button  and load the image “Srtm30_shdbath.jp2”.  
Note:  If this image looks extremely pixilated, try zooming out to the full extent 
of the view using the standard ArcView Zoom to Full Extent button , and 
then back to your original extent using the standard ArcView Zoom to Previous 
Extent button .  This usually fixes the pixilation problem.

❑ 3. Click on the  button and load the following datasets.  You can find 
them by either typing the name or filename in the “Search Text” textbox (you may 
use the * and ? wildcard characters), or by clicking on the respective DBC and 
finding the file in the list.
a. FAO National-Ad1 Boundaries (Ad1_Py.shp); from the Additional Vector 

Data DBC.
b. FAO-AquaStat 1:1m Major African SWBs (wria_swb.shp); from the Surface 

Waterbody DBC.
c. FAO-AquaStat 1:5m African Rivers (wria_riv.shp); from the Surface 

Waterbody DBC.

Change the theme names to the short versions by clicking the “View” menu item 
“Toggle AWRD data to Short Theme Names.”  You might have to click this menu item 
two times.

Make sure your themes are sorted correctly in the View Table of Contents.  They 
should be in the following order:
❑ 1. Ad1_Py.shp 
❑ 2. alcomwwf.shp
❑ 3. wria_swb.shp
❑ 4. wria_riv.shp
❑ 5. SRTM30_ShdBath.jp2

Set the legend properties of Ad1_Py.shp so that only the borders are visible:
❑ 1. Click on Ad1_py.shp in the View Table of Contents so that it is the active 

theme.
❑ 2. Click the “Theme” menu, then “Adjust Polygon Border and Pattern…”.
❑ 3. Choose the option “Use Outline”.
❑ 4. Choose the option “Constant Outline Color”
❑ 5. Click the “Set Color” button and choose a light gray color.
❑ 6. Set the “Outline Width” = 1.5
❑ 7. Choose the hollow pattern (the pattern symbol in the top left corner of the list of 

available patterns).
❑ 8. Click “OK”.
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Find and zoom in to Lake Tanganyika:
❑ 1. Click on the wria_swb.shp theme in the View Table of Contents to make it the 

active theme.
❑ 2. Click the  button to open the “Find Location by Theme” dialog.
❑ 3. Set the “Theme to Search” = “wria_swb.shp”, and the “Field to Search” = “Swb_

name”.
❑ 4. Enter the search term “tanganyika”.
❑ 5. Select “Tanganyika [rec. 342]” in the list and click “OK” to zoom in to Lake 

Tanganyika.

Display and zoom in to the hydrological network associated with Lake Tanganyika:
❑ 1. Use the “Identify Upstream and Downstream Watersheds” tool  to click on 

Lake Tanganyika.
❑ 2. Click the “Zoom to Extent of Upstream and Downstream Polygons” button  

to see the full drainage system associated with Lake Tanganyika.
❑ 3. Change the legend symbols associated with the watershed model by clicking the 

 button.  Choose the legend named “just_primary.avl”.

Change the theme names back to the long versions by clicking the “View” menu item 
“Toggle AWRD data to Long Theme Names.”

Change the name of the theme “ALCOM-WWF Watershed Model” to “Lake 
Tanganyika Flow Regime”.
❑ 1. Select the theme “ALCOM-WWF Watershed Model in the View Table of 

Contents to make it active.
❑ 2. Click the “Theme” menu, then “Properties”, to open the “Theme Properties” 

dialog.
❑ 3. Enter the new theme name “Lake Tanganyika Flow Regime” into the “Theme 

Name” text box.

Add Country Name labels to your view:
❑ 1. Open your ArcView symbol window by either clicking [CONTROL]-P, or 

clicking the “Window” menu and then “Show Symbol Window…”.
❑ 2. In the Symbol Window, set the default text to be Times New Roman, with “Size” 

= 14 and “Style” = “Bold”.
❑ 3. Click the theme “FAO National-Ad1 Boundaries” in your View Table of 

Contents to make it the active theme.
❑ 4. Open the Auto-Label dialog by either clicking [CONTROL]-L, or by clicking 

the “Theme” menu and then “Auto-Label…”.
❑ 5. Set the Label Field = “Country_na”
❑ 6. Choose the option “Find Best Label Placement
❑ 7. Choose the option “Remove Duplicates”
❑ 8. Choose the option “Scale Labels”
❑ 9. Click “OK”. 
❑ 10. You will probably need to adjust some of the names, either moving them or 

changing the text.  To change the text, double-click on the label with the  tool 
and then type in the correct text.

❑ 11. If you wish to add country name labels manually, use the ArcView Label tool 
 to click on the view wherever you wish to place a new label.
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Convert the view to a 20 cm x 16 cm layout:
❑ 1. Click the “ImageExport” menu, then “Create LO/ViewFrame-Page”
❑ 2. Set the Page Setup “Units” = “Centimeters”
❑ 3. Set the “Width” = 20
❑ 4. Set the “Height” = 16
❑ 5. The layout will appear, and the only thing you will see on the layout will be the 

view frame containing the view.  
❑ 6. Double-click on the view frame to open the View Frame Properties dialog.
❑ 7. Set the “Scale” – “User Specified Scale”
❑ 8. Set the scale value = 14000000 (14 million)
❑ 9. Click “OK”.

Note that the layout is linked to the view.  If you move or add anything to the view, 
it will also appear in the layout.  You may wish to try panning the view using the 
ArcView Pan tool  and observing the effects on the layout.  You will often need to 
pan the view a bit to get the image in the layout positioned correctly, especially after 
adding features like legends to the layout.

Add a legend to your layout, explaining the colors that correspond with each 
population density level:
❑ 1. Click the Custom Legend Tool  in your Layout tool bar.
❑ 2. Click in your layout somewhere, to open the “Custom Legend” dialog.
❑ 3. Read the introductory text, then click “Next” to go to Step 1 of the Custom 

Legend Tool.
❑ 4. While in Step 1 of the Custom Legend tool:

a. Set the View = “Lake Tanganyika”
b. Select the theme “Lake Tanganyika Flow Regime” to show in your custom 

legend.
c. Select the theme “FAO-AquaStat 1:5m African Rivers” to show in your 

custom legend tool.
d. For the “number of label and symbol columns”, select “2”.
e. Click “Next” to go to Step 2.

❑ 5. While in Step 2 of the Custom Legend Tool:
a. Delete the text in the “Optional Title” textbox. This will automatically 

disable the remaining options.
b. Click “Next” to go to Step 3.

❑ 6. While in Step 3 of the Custom Legend Tool:
a. Select the top border style (a single line).
b. Set the “Border Width” = 1.5
c. Set the “Border Color” = “Black”
d. Set the “Background Color” = “White”
e. Select the option “Round corners”
f. Click “Next” to go to Step 4.

❑ 7. While in Step 4 of the Custom Legend Tool:
a. Select the option to show area symbols as Rectangles.
b. Select the option to show line symbols as horizontal lines.
c. Click “Next” to go to Step 5.

❑ 8. While in Step 5 of the Custom Legend Tool:
a. Leave the default values as they are.
b. Click the “Preview” button to see how the legend looks.
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c. It will probably be to large, but that can be fixed later.  Decide if you like the 
text and colors of the legend.  If it is acceptable, click “Finish” to close the 
Custom Legend Tool.

❑ 9. The legend will probably need to be moved and resized:
a. Use the ArcView Pointer tool  to select your new legend.
b. Drag the legend down to the lower left corner of the layout.
c. If you wish to resize the legend, click on one of the corner handles and drag 

it to change the dimensions.  
d. Position and size the legend so that it looks good to you.
e. If you wish, you can decompose the legend into separate elements by 

clicking the ArcView Ungroup button .  You may need to click it several 
times before you get all the subgroups split up.  Then you can select each 
individual element and modify it using the Symbol Window.  For example, 
you could set the some of the text to be a different font or a larger font size.  
It would be a good idea to regroup the legend elements when you finish 
(select them all, then click the ArcView Group button ), so that the 
entire legend can easily be resized or repositioned.

Export the layout to a *.jpg image:
❑ 1. Click the “ImageExport” menu, then “Output a Single Pixmap”.
❑ 2. For Output Image Type, select “JPG”.
❑ 3. Select a name and location to create your image file.
❑ 4. Select a resolution = 200 for the image file.  Note:  Often the default resolution 

value will produce a very high-resolution image, and you can usually reduce the 
default value to keep down the image size.

❑ 5. The layout will change size while the function is working.  Upon completion, 
you will see a report of some statistical information on the pixel size.  Note:  If 
possible, this function will also create a “World File” that allows the image to be 
used in a GIS system.  The report also gives details on the data included in the 
world file.

❑ 6. Click “OK” to close the report, and your layout will return to the proper size.

Part 4: Map of Nile megabasin wetlands
This exercise will generate a simple map with no background to distract from the 
main image, introducing the concept of a mask.  This exercise will also introduce some 
common map elements such as a title, scale bar and north arrow.

Materials and methods 
Data utilized
This exercise uses the ALCOM-WWF watershed model to identify the region of the 
Nile River Megabasin. The WCMC Wetlands are then displayed within the Nile River 
Megabasin (Table 2.36).
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TABLE 2.36
Summary and purpose of data used

Name Description Filename File location Data utilization or 
purpose

ALCOM-WWF 
Watershed Model

A three level named 
watershed model of 
continental Africa

alcomwwf.shp [AWRD_Data]\ws_dbc\ Used to identify the 
region of the Nile 
River megabasin.

Consolidated 
WCMC Wetlands

Seamless 
recompilation of 
country based 
wetlands

Wtlnd_Py.shp [AWRD_Data]\data\swb_dbc A source of surface 
waterbodies in 
the Nile River 
megabasin.

Methods
Open ArcView and start the exercise by following the steps below.

Open a new view and name it “Nile Megabasin Wetlands”.

Add the following data:
❑ 1. Set the watershed model to “alcomwwf.shp” and attach the annual precipitation 

data:
a. Click the menu “AWRD Modules”, then the menu item “Change 

Watershed Model”.
b. Select “alcomwwf.shp” from the list of “Available Watershed Models”.
c. This exercise does not require any additional data.  You may select any 

datasets you wish or none at all.
d. Click ‘OK’.  If “alcomwwf.shp” is not already in your view, you will now 

be asked if you would like to add it to the view.  Click “Yes”.

❑ 2. Click on the  button and load the following dataset.  You can find 
it by either typing the name or filename in the “Search Text” textbox (you may use 
the * and ? wildcard characters), or by clicking on the Surface Waterbody DBC 
and finding the file in the list.
a. Consolidated WCMC Wetlands (Wtlnd_Py.shp); from the Surface 

Waterbodies DBC.

Change the theme names to the short versions by clicking the “View” menu item 
“Toggle AWRD data to Short Theme Names.”  You might have to click this menu item 
two times.

Make sure your themes are sorted correctly in the View Table of Contents.  They 
should be in the following order:
❑ 1. Wtlnd_Py.shp 
❑ 2. alcomwwf.shp

Select the region of the Nile River megabasin:
❑ 1. Click on alcomwwf.shp in the View Table of Contents, making it the Active 

theme.
❑ 2. Click the “Select Upstream and Downstream Watersheds” tool .
❑ 3. Select the option “Include Entire Basin”.
❑ 4. Select the option “Make New Selection”. 
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❑ 5. Click anywhere in the Nile River megabasin to select the entire megabasin.  Hint:  
Lake Victoria is in the Nile River megabasin, and is an easy feature to find.

Create a mask and zoom in to the Nile River megabasin:
❑ 1. While the Nile River megabasin is selected, click the ImageExport menu, and then 

“Create Fitted Map”.  This function will create a new shapefile which will act as 
a mask for the selected area.

❑ 2. Specify the name and location for your mask shapefile.  This exercise will use the 
name “nile_mask.shp”.

❑ 3. It may take a few minutes to make the mask shapefile, so be patient.  When it 
finishes, it will add the mask shapefile to your view and zoom in to the selected 
area. It will also make a layout which is linked to the view.

Adjust the mask legend properties:
❑ 1. Double-click on nile_mask.shp in the Theme Table of Contents to open up the 

Legend Editor.
❑ 2. Double-click on the symbol for Mask Value = 0 to open up the Symbol Window.  

This are a represents the interior of the Nile River megabasin.
❑ 3. Set a hollow symbol (in the upper left corner of the list of symbols), with an 

outline width of 2.
❑ 4. Close the Symbol Window and click “Apply” on the Legend Editor window.
❑ 5. Double-click on the symbol for Mask Value = 1 to open the Symbol Window.  

This area represents the exterior of the Nile River megabasin, and will be masked 
out in the final map.

❑ 6. Select a solid symbol (in the middle of the top row of the list of symbols), with an 
outline width of “None”.  Set the Foreground Color = white.

Change the theme names to the long versions by clicking the “View” menu item 
“Toggle AWRD data to Long Theme Names.”

If you wish, you may adjust your WCMC legend properties, by either changing the 
color of any wetland types to make them more distinctive, or by deleting any types 
that you do not wish to include in the map.  All these functions are done in the Legend 
Editor.

Open your layout that was created when you made the mask.  Note that the layout is 
linked to the view.  If you move or add anything to the view, it will also appear in the 
layout.  You may wish to try panning the view using the ArcView Pan tool  and 
observing the effects on the layout.  You will often need to pan the view a bit to get the 
image in the layout positioned correctly, especially after adding features like legends 
to the layout.
❑ 1. Double-click on the view frame to open the View Frame Properties dialog.
❑ 2. Set the “Scale” – “User Specified Scale”
❑ 3. Set the scale value = 17000000 (17 million)
❑ 4. Click “OK”.

Add a legend to your layout, explaining the colors that correspond with each wetland 
type:

❑ 1. Click the Custom Legend Tool  in your Layout tool bar.
❑ 2. Click in your layout somewhere, to open the “Custom Legend” dialog.
❑ 3. Read the introductory text, then click “Next” to go to Step 1 of the Custom 

Legend Tool.
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❑ 4. While in Step 1 of the Custom Legend tool:
a. Set the View = “Nile Megabasin Wetlands”
b. Select the theme “Consolidated WCMC Wetlands” to show in your custom 

legend.
c. For the “number of label and symbol columns”, select “One per theme”.
d. Click “Next” to go to Step 2.

❑ 5. While in Step 2 of the Custom Legend Tool:
a. Set the “Optional Title” = “Legend”
b. Set the “Title Font” = “Arial”
c. Set the “Title Size (pts)” = 18
d. Set the “Title Style” = “Normal”
e. On the “Title Positioning Options, choose the option that is centered 

directly above the image.
f. Click “Next” to go to Step 3.

❑ 6. While in Step 3 of the Custom Legend Tool:
a. Select the top border style (a single line).
b. Set the “Border Width” = 1.5
c. Set the “Border Color” = “Black”
d. Set the “Background Color” = “White”
e. Select the option “Round corners”
f. Click “Next” to go to Step 4.

❑ 7. While in Step 4 of the Custom Legend Tool:
a. Select the option to show area symbols as Rectangles.
b. The option for line symbols does not apply here, as there are no polyline 

themes being symbolized in this legend.
c. Click “Next” to go to Step 5.

❑ 8. While in Step 5 of the Custom Legend Tool:
a. Leave the default values as they are.
b. Click the “Preview” button to see how the legend looks.
c. It will probably be to large, but that can be fixed later.  Decide if you like the 

text and colors of the legend.  If it is acceptable, click “Finish” to close the 
Custom Legend Tool.

❑ 9. The legend will probably need to be moved and resized:
a. Use the ArcView Pointer tool  to select your new legend.
b. Drag the legend down to the lower left corner of the layout.
c. If you wish to resize the legend, click on one of the corner handles and drag 

it to change the dimensions.  
d. Position and size the legend so that it looks good to you.
e. If you wish, you can decompose the legend into separate elements by 

clicking the ArcView Ungroup button .  You may need to click it several 
times before you get all the subgroups split up.  Then you can select each 
individual element and modify it using the Symbol Window.  For example, 
you could set the some of the text to be a different font or a larger font size.  
It would be a good idea to regroup the legend elements when you finish 
(select them all, then click the ArcView Group button ), so that the 
entire legend can easily be resized or repositioned.
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Add a Scale Bar to your layout:
❑ 1. Click the “Scale Bar Frame” tool  in the Layout tool bar.  If you do not see 

the  button, then click on the  tool and hold it down for a second.  You should 
see the scale bar tool appear below the  tool, where you can select it from a 
list.  Note:  you should also see the North Arrow tool , which you will need 
shortly.

❑ 2. Use the Scale Bar tool to draw a box on the layout to hold your scale bar.
❑ 3. In the Scale Bar Properties dialog:

a. Select the view frame named “Nile Megabasin Wetlands”.
b. Check the option “Preserve Interval”.
c. Select the “Units” = “Kilometers”
d. Set the “Interval” = 200
e. Set “Intervals” = 3
f. Set “Left Divisions” = 2
g. If you are unable to set these values, just stick with an Interval = 200, then 

resize the scale bar later by selecting it and pulling on one of the handles.
h. Click “OK” to add the scale bar to the layout.

❑ 4. If you wish, you may change the font of the scale bar text by selecting the scale 
bar with the  tool, and then clicking [CONTROL]-P to open the Symbol 
Window.  Use the Symbol Window to set the font properties.  While it is selected, 
you can also move it around and resize it.

Add a North Arrow to your layout:
❑ 1. Use the North Arrow tool to draw a box on the layout.
❑ 2. Pick the North Arrow you wish to use from the North Arrow Manager dialog.
❑ 3. Click “OK” to add the north arrow to the layout.
❑ 4. If you wish, you may change the size or location of the north arrow with the  

tool.

Add a title to your layout:
❑ 1. Use the Text tool  to click on the layout.
❑ 2. In the “Text Properties” dialog, enter the text “Nile Megabasin Wetlands”
❑ 3. Click “OK”.
❑ 4. Select the title using the  tool.
❑ 5. Click [CONTROL]-P to open the Symbol Window dialog.
❑ 6. Set the “Font” = “Verdana”
❑ 7. Set the “Size” = 30    (just type it into the box, rather than selecting from the drop-

down list).
❑ 8. Set the “Style” = Italic
❑ 9. Close the Symbol Window and drag the title to the position you prefer.

Export the layout to a *.jpg image:
❑ 1. Click the “ImageExport” menu, then “Output a Single Pixmap”.
❑ 2. For Output Image Type, select “JPG”.
❑ 3. Select a name and location to create your image file.
❑ 4. Select a resolution = 200 for the image file.  Note:  Often the default resolution 

value will produce a very high-resolution image, and you can usually reduce the 
default value to keep down the image size.
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❑ 5. The layout will change size while the function is working.  Upon completion, 
you will see a report of some statistical information on the pixel size.  Note:  If 
possible, this function will also create a “World File” that allows the image to be 
used in a GIS system.  The report also gives details on the data included in the 
world file.

❑ 6. Click “OK” to close the report, and your layout will return to the proper size.

Part 5: Map of road network of the Republic of Ghana
This exercise illustrates the use of a predefined set of themes and graphics, automatically 
loaded by a single function, which greatly simplifies the creation of complex base maps.  
This example will demonstrate how to easily generate a map of the road network of 
the Republic of Ghana.

Materials and methods 
Data utilized
This exercise uses a large set of data automatically loaded with the file “BaseMap-
Large.odb” (Table 2.37).

TABLE 2.37
Summary and purpose of data used

Name Description Filename File location Data utilization or 
purpose

BaseMap-Large.
odb

A set of 34 themes 
loaded automatically 
as a single entity.  
The themes include 
graphics and 
minimum/maximum 
display scales.

BaseMap-Large.
odb

[AWRD_Data]\misc\
bmap_odb\

A simple means to 
automatically load a 
large set of themes 
and graphics.

Methods
Open ArcView and start the exercise by following the steps below.

Make a new view and name it “Ghana Road Network”.  While the View Properties 
window is open, set the “Map Units” = “Decimal Degrees”.

Load the themes stored in BaseMap-Large.odb:
❑ 1. Click the “ImageExport” menu, and then “Load Theme Database”.
❑ 2. Choose to import the ODB into the existing (current) view.
❑ 3. Select the file “basemap-large.odb” and click “OK”.
❑ 4. If you wish, explore this dataset by zooming in to different areas and viewing the 

types of themes that are included.  Most of these themes are set so that they are 
only visible at certain scale ranges.

Zoom in to Ghana and turn on only the themes to include in the final map:
❑ 1. After you are through exploring, turn off all the themes by clicking the “View” 

menu, then “Themes Off”.
❑ 2. Turn on the following themes:

a. Ad2-National and Sovereign Boundaries (Ln)
b. Capital Cities
c. VMap Roads
d. DCW SWB (Py)
e. Ad2-National and Sovereign Boundaries (Py)
f. Generalized Relief Shaded
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Create a mask and zoom in to the Republic of Ghana:
❑ 1. Set “Ad1-National and Sovereign Boundaries” to visible.
❑ 2. This theme will only show in the view if the view scale is between 15 000 000 and 

50 000 000.  Therefore set the view scale to 40 000 000.
❑ 3. Click the theme “Ad1-National and Sovereign Boundaries” to make it the active 

theme.  
❑ 4. Use the Query Builder tool  to select the country of Ghana, using the 

following query string:
( [Propr_nam1] = “Ghana” )

❑ 5. While Ghana is selected, click the ImageExport menu, and then “Create Fitted 
Map”.  This function will create a new shapefile which will act as a mask for the 
selected area.

❑ 6. Specify the name and location for your mask shapefile.  This exercise will use the 
name “ghana_mask.shp”.

❑ 7. It may take a few minutes to make the mask shapefile, so be patient.  When it 
finishes, it will add the mask shapefile to your view and zoom in to the selected 
area. It will also make a layout which is linked to the view.

❑ 8. You will not be using this pre-defined layout, so you can close it and delete it.

Adjust the mask legend properties:
❑ 1. Double-click on ghana_mask.shp in the Theme Table of Contents to open up the 

Legend Editor.
❑ 2. Double-click on the symbol for Mask Value = 1 to open up the Symbol 

Window.
❑ 3. Set a hollow symbol (in the upper left corner of the list of symbols), with an 

outline width of “None”.
❑ 4. Close the Symbol Window and click “Apply” on the Legend Editor window.
❑ 5. Double-click on the symbol for Mask Value = 2 to open the Symbol Window.
❑ 6. Select a solid symbol (in the middle of the top row of the list of symbols), with an 

outline width of “None”.  Set the Foreground Color = gray.

Add Region Name labels to your view:
❑ 1. Open your ArcView symbol window by either clicking [CONTROL]-P, or 

clicking the “Window” menu and then “Show Symbol Window…”.
❑ 2. In the Symbol Window, set the default text to be Times New Roman, with “Size” 

= 14 and “Style” = “Bold Italic”.
❑ 3. Click the theme “Ad2-National and Sovereign Boundaries (Py)” in your View 

Table of Contents to make it the active theme.

❑ 4. Use the ArcView Label tool  to click on each of the ten regions in Ghana to 
add labels to them.  If you wish to delete a label, select it with the  tool and 
click the “Delete” key.

Convert the view to a 20 cm x 16 cm layout:
❑ 1. Click the “ImageExport” menu, then “Create LO/ViewFrame-Page”
❑ 2. Set the Page Setup “Units” = “Centimeters”
❑ 3. Set the “Width” = 20
❑ 4. Set the “Height” = 16
❑ 5. The layout will appear, and the only thing you will see on the layout will be the 

view frame containing the view.  
❑ 6. Double-click on the view frame to open the View Frame Properties dialog.
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❑ 7. Set the “Scale” – “User Specified Scale”
❑ 8. Set the scale value = 5000000 (5 million)
❑ 9. Click “OK”.

Note that the layout is linked to the view.  If you move or add anything to the view, 
it will also appear in the layout.  You may wish to try panning the view using the 
ArcView Pan tool  and observing the effects on the layout.  You will often need to 
pan the view a bit to get the image in the layout positioned correctly, especially after 
adding features like legends to the layout.

Add a legend to your layout, explaining the symbols that correspond with each class 
of road:
❑ 1. Click the Custom Legend Tool  in your Layout tool bar.
❑ 2. Click in your layout somewhere, to open the “Custom Legend” dialog.
❑ 3. Read the introductory text, then click “Next” to go to Step 1 of the Custom 

Legend Tool.
❑ 4. While in Step 1 of the Custom Legend tool:

a. Set the View = “Ghana Road Network”
b. Select the theme “VMap Roads” to show in your custom legend.
c. For the “number of label and symbol columns”, select “One per theme”.
d. Click “Next” to go to Step 2.

❑ 5. While in Step 2 of the Custom Legend Tool:
g. Set the “Roads of Ghana” = “Legend”
h. Set the “Title Font” = “Arial”
i. Set the “Title Size (pts)” = 18
j. Set the “Title Style” = “Normal”
k. On the “Title Positioning Options, choose the option that is centered 

directly above the image.
a. Click “Next” to go to Step 3.

❑ 6. While in Step 3 of the Custom Legend Tool:
a. Select the top border style (a single line).
b. Set the “Border Width” = 1.5
c. Set the “Border Color” = “Black”
d. Set the “Background Color” = “White”
e. Select the option “Round corners”
f. Click “Next” to go to Step 4.

❑ 7. While in Step 4 of the Custom Legend Tool:
a. The option for area symbols does not apply here, as there are no polygon 

themes being symbolized in this legend.
b. Select the option to show line symbols as horizontal lines.
c. Click “Next” to go to Step 5.

❑ 8. While in Step 5 of the Custom Legend Tool:
a. Leave the default values as they are.
b. Click the “Preview” button to see how the legend looks.
c. It will probably be to large, but that can be fixed later.  Decide if you like the 

text and colors of the legend.  If it is acceptable, click “Finish” to close the 
Custom Legend Tool.

❑ 9. The legend will probably need to be moved and resized:
a. Use the ArcView Pointer tool  to select your new legend.
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b. Drag the legend down to the lower left corner of the layout.
c. If you wish to resize the legend, click on one of the corner handles and drag 

it to change the dimensions.  
d. Position and size the legend so that it looks good to you.
e. If you wish, you can decompose the legend into separate elements by 

clicking the ArcView Ungroup button .  You may need to click it several 
times before you get all the subgroups split up.  Then you can select each 
individual element and modify it using the Symbol Window.  For example, 
you could set the some of the text to be a different font or a larger font size.  
It would be a good idea to regroup the legend elements when you finish 
(select them all, then click the ArcView Group button ), so that the 
entire legend can easily be resized or repositioned.

Add a Scale Bar to your layout:
❑ 1. Click the “Scale Bar Frame” tool  in the Layout tool bar.  If you do not see 

the  button, then click on the  tool and hold it down for a second.  You should 
see the scale bar tool appear below the  tool, where you can select it from a 
list.  Note:  you should also see the North Arrow tool , which you will need 
shortly.

❑ 2. Use the Scale Bar tool to draw a box on the layout to hold your scale bar.
❑ 3. In the Scale Bar Properties dialog:

a. Select the view frame named “Ghana Road Network”.
b. Check the option “Preserve Interval”.
c. Select the “Units” = “Kilometers”
d. Set the “Interval” = 50
e. Set “Intervals” = 3
f. Set “Left Divisions” = 2
g. If you are unable to set these values, just stick with an Interval = 50, then 

resize the scale bar later by selecting it and pulling on one of the handles.
h. Click “OK” to add the scale bar to the layout.

❑ 4. If you wish, you may change the font of the scale bar text by selecting the scale 
bar with the  tool, and then clicking [CONTROL]-P to open the Symbol 
Window.  Use the Symbol Window to set the font properties.  While it is selected, 
you can also move it around and resize it.

Add a North Arrow to your layout:
❑ 1. Use the North Arrow tool to draw a box on the layout.
❑ 2. Pick the North Arrow you wish to use from the North Arrow Manager dialog.
❑ 3. Click “OK” to add the north arrow to the layout.
❑ 4. If you wish, you may change the size or location of the north arrow with the  

tool.

Add a title to your layout:
❑ 1. Use the Text tool  to click on the layout.
❑ 2. In the “Text Properties” dialog, enter the text “Ghana”
❑ 3. Click “OK”.
❑ 4. Select the title using the  tool.
❑ 5. Click [CONTROL]-P to open the Symbol Window dialog.
❑ 6. Set the “Font” = “Verdana”
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❑ 7. Set the “Size” = 30    (just type it into the box, rather than selecting from the drop-
down list).

❑ 8. Set the “Style” = Italic
❑ 9. Close the Symbol Window and drag the title to the position you prefer.

Export the layout to a *.jpg image:
❑ 1. Click the “ImageExport” menu, then “Output a Single Pixmap”.
❑ 2. For Output Image Type, select “JPG”.
❑ 3. Select a name and location to create your image file.
❑ 4. Select a resolution = 200 for the image file.  Note:  Often the default resolution 

value will produce a very high-resolution image, and you can usually reduce the 
default value to keep down the image size.

❑ 5. The layout will change size while the function is working.  Upon completion, 
you will see a report of some statistical information on the pixel size.  Note:  If 
possible, this function will also create a “World File” that allows the image to be 
used in a GIS system.  The report also gives details on the data included in the 
world file.

❑ 6. Click “OK” to close the report, and your layout will return to the proper size.

Part 6: Reference base map of the Republic of Uganda:
This exercise uses a large set of data automatically loaded with the files “BaseMap-
Medium_Set1.odb” and “BaseMap-Medium_Set2.odb”.  This exercise also incorporates 
the background image “Classified SRTM30as DEM w/ETopo2 Bathymetry”.

Materials and methods 
Data utilized
This exercise is similar to the last one, in that it illustrates the use of a predefined set 
of themes and graphics to simplify the creation of complex base maps.  This example 
will demonstrate how to easily generate a general base map of the Republic of Uganda 
(Table 2.38).

TABLE 2.38
Summary and purpose of data used

Name Description Filename File location Data utilization or 
purpose

BaseMap-
Medium_Set1.
odb

A set of 19 themes 
loaded automatically 
as a single entity.  
The themes include 
graphics and 
minimum/maximum 
display scales.

BaseMap-
Medium_Set1.
odb

[AWRD_Data]\misc\
bmap_odb\

A simple means 
to automatically 
load a large set 
of themes and 
graphics.

BaseMap-
Medium_Set2.
odb

A detailed set of 
graphic names for 
populated places.

BaseMap-
Medium_Set2.
odb

[AWRD_Data]\misc\
bmap_odb\

A simple means to 
automatically load 
a point theme of 
populated places, 
plus associated 
graphics.

Classified 
SRTM30as 
DEM w/ETopo2 
Bathymetry

SRTM 30as elevation 
and ETopo2 
bathymetric relief 
classes

Af_Rlf3d.jp2 [AWRD_Data]\aimg_dbc\ Background 
reference.  
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Methods
Open ArcView and start the exercise by following the steps below.

Make a new view and name it “Uganda”.  While the View Properties window is open, 
set the “Map Units” = “Decimal Degrees”.

Load the themes stored in BaseMap-Medium_Set1.odb and BaseMap-Medium_Set2.
odb:
❑ 1. Click the “ImageExport” menu, and then “Load Theme Database”.
❑ 2. Choose to import the ODB into the existing (current) view.
❑ 3. Select the file “basemap-medium_set1.odb” and click “OK”.
❑ 4. Click the “ImageExport” menu, and then “Load Theme Database”.
❑ 5. Choose to import the ODB into the existing (current) view.
❑ 6. Select the file “basemap-medium_set2.odb” and click “OK”.
❑ 7. If you wish, explore these datasets by zooming in to different areas and viewing 

the types of themes that are included.  Most of these themes are set so that they 
are only visible at certain scale ranges.

Reset the basemap background image:
❑ 1. Turn off the visibility of “Srtm30_flat.jp2”.
❑ 2. Turn off the visibility of “Etopo_2_2-5d.jp2
❑ 3. Click the Add Basemap button  and load the image “Af_Rlf3d.jp2”.  Note:  If 

this image looks extremely pixilated, try zooming out to the full extent of the view 
using the standard ArcView Zoom to Full Extent button , and then back to 
your original extent using the standard ArcView Zoom to Previous Extent button 

.  This usually fixes the pixilation problem.

Zoom in to Uganda:
❑ 1. Click the theme “Ad1-National and Sovereign Boundaries” to make it the active 

theme.  
❑ 2. Use the Query Builder tool  to select the country of Ghana, using the 

following query string:
( [Ad1_name] = “Uganda” )

❑ 3. Zoom in to Uganda using the ArcView Zoom to Selected button .

Add Country Name labels to your view:
❑ 1. Open your ArcView symbol window by either clicking [CONTROL]-P, or 

clicking the “Window” menu and then “Show Symbol Window…”.
❑ 2. In the Symbol Window, set the default text to be Times New Roman, with “Size” 

= 24 and “Style” = “Bold Italic”.  Set the text color = dark gray.
❑ 3. Click the theme “Ad1-National and Sovereign Boundaries (Py)” in your View 

Table of Contents to make it the active theme.
❑ 4. Drag  “Ad1-National and Sovereign Boundaries (Py)” to the bottom of the table 

of contents, so that it is underneath all the other themes.
❑ 5. Open the Theme Properties for  “Ad1-National and Sovereign Boundaries (Py)” 

by clicking the “Theme” Menu, then “Properties”.
❑ 6. Scroll down to the “Display” icon on the left side of the “Properties” dialog.
❑ 7. Click the “Display” icon, and delete both the Minimum and Maximum scale.
❑ 8. Use the ArcView Label tool  to click on each of the countries in the view to 

add labels to them.  If you wish to delete a label, select it with the  tool and 



click the “Delete” key.  If you wish to edit the label, double-click on it with the 
 tool and enter the new text in the “Text Properties” dialog.

Convert the view to a 20 cm x 16 cm layout:
❑ 1. Click the “ImageExport” menu, then “Create LO/ViewFrame-Page”
❑ 2. Set the Page Setup “Units” = “Centimeters”
❑ 3. Set the “Width” = 20
❑ 4. Set the “Height” = 16
❑ 5. The layout will appear, and the only thing you will see on the layout will be the 

view frame containing the view.  
❑ 6. Double-click on the view frame to open the View Frame Properties dialog.
❑ 7. Set the “Scale” – “User Specified Scale”
❑ 8. Set the scale value = 5000000 (5 million)
❑ 9. Click “OK”.

Note that the layout is linked to the view.  If you move or add anything to the view, 
it will also appear in the layout.  You may wish to try panning the view using the 
ArcView Pan tool  and observing the effects on the layout.  You will often need to 
pan the view a bit to get the image in the layout positioned correctly, especially after 
adding features like legends to the layout.

Export the layout to a *.jpg image:
❑ 1. Click the “ImageExport” menu, then “Output a Single Pixmap”.
❑ 2. For Output Image Type, select “JPG”.
❑ 3. Select a name and location to create your image file.
❑ 4. Select a resolution = 200 for the image file.  Note:  Often the default resolution 

value will produce a very high-resolution image, and you can usually reduce the 
default value to keep down the image size.

❑ 5. The layout will change size while the function is working.  Upon completion, 
you will see a report of some statistical information on the pixel size.  Note:  If 
possible, this function will also create a “World File” that allows the image to be 
used in a GIS system.  The report also gives details on the data included in the 
world file.

❑ 6. Click “OK” to close the report, and your layout will return to the proper size.

Exercise Summary
This exercise has demonstrated how to create high-quality, high-resolution base map 
images for use in publications and presentations.  The image-export functions provided 
with the AWRD far exceed the standard layout export tools included with ArcView, 
and provide a valuable resource for land managers and researchers who wish to create 
effective, clear and readable maps.
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